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WARRANTY
Proxima Corporation warrants that the Proxima® Desktop Projector™ product manufactured by Proxima is free from
defects in materials and workmanship under normal use during the Warranty Period. The Warranty Period commences
on the day of purchase by the end-user. The Warranty Period is one year. The projector lamp is not covered by this
Warranty.

Each Proxima product is manufactured from new parts, or new and some used parts. In some cases, the product may
have been delivered to another end-user and then returned. In all cases, the product has undergone testing and quality
inspection, and Proxima's full warranty terms apply.

The end-user’s sales receipt or invoice showing the date of purchase of the product and the name of the Reseller is proof
of date of purchase. The Warranty extends only to the original purchaser and is not transferable.

During the Warranty Period, Proxima will, at no additional charge, repair or replace defective parts or at the option of
Proxima, replace the entire unit.

This limited Warranty does not extend to any Proxima product that has been damaged or been rendered defective (a) as
a result of accident, misuse or other abuse; (b) by the use of parts not manufactured or sold by Proxima; (c) by
modification of the product; or (d) as a result of servicing by non-authorized
personnel.

LIMITATION OF WARRANTIES
The foregoing Warranty is expressly in lieu of any other expressed or implied, warranties, including,
without limitation, warranties of merchantability or fitness for a particular purpose. To the extent not
prohibited by law, all statutory warranties are hereby waived and excluded from this Warranty. Proxima expressly
disclaims all warranties not stated in this Limited Warranty.

FCC STATEMENT
Warning:  This is a Class A product. In a domestic environment this product may cause radio interference, in which case
the user may be required to take adequate measures.

Warning: This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause interference to radio communications. It has been tested and found
to comply with limits for a Class “A” computing device pursuant to Subpart B of Part 15 of the FCC Rules, which are
designed to provide reasonable protection against such interference when operated in a commercial environment.
Operation of this equipment in a residential area is likely to cause interference in which case the user, at his own
expense, will be required to take whatever measures may be necessary to correct the interference.

TRADEMARKS, PATENTS, AND COPYRIGHTS
Proxima and Cyclops are registered trademarks; MediaExpress is a trademark of Proxima Corporation. LightBoard, and
Fit-To-View are trademarks of Proxima Corporation. Desktop Projector, Desktop Projection are trademarks of Proxima
Corporation. Macintosh is a registered trademark of Apple Computer, Inc. Other trademarks are the property of their
respective owners. This product is covered by the following U.S. patent number: 5,510,861. Foreign patents applied for.

© 1996 Proxima Corporation. All rights reserved. Specifications are subject to change without notice.
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Introducing the DP9100    i-1

Introducing the DP9100

The Proxima® Desktop Projector™ family consists of portable, color data and
video LCD projectors that make sharing data and presenting information as
easy as connecting your computer to your monitor.

The Desktop Projector 9100 is a high-resolution multimedia LCD projector
that offers a high-quality, extremely bright image. It is compatible with a
wide range of computers and resolutions—from 640 x 480 personal
computers to 1280 x 1024 workstations.

Projected Image

File   Edit   V
iew

Projected Image

File   Edit   View

Figure i-1 The Proxima Desktop Projector 9100 in use
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i-2    Introduction

CYCLOPS INTERACTIVE POINTER SYSTEM

All Proxima Desktop Projector products come Cyclops®-ready. The Cyclops
interactive pointer system functions like a cordless mouse, allowing you to
control your computer and software by pointing at the projection screen.

INTRODUCING THE MEDIAEXPRESS SYSTEM

The MediaExpress™ Image Display System is a hybrid, next-generation
product that brings the functionality of computers and projectors much
closer together.

The MediaExpress system eliminates the need to connect a computer to the
projector. Just save your presentation from whatever application you’re using
to a special kind of file (called a .PDF file), copy the file on a disk, then
place the disk in the MediaExpress disk drive and start the show.

If you’d like to order the MediaExpress system, contact your local dealer or
refer to Appendix B for ordering information.
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Introducing the DP9100    i-3

WHAT’S IN THE BOX?

After you open the box and remove the projector and the
shrink-wrapped accessory packs, make sure you have all of the items shown
below.

Proxima Desktop 

Projector 9100

Remote Control

(A95)

Power Cord

(C1002–10)

VGA to LCD Cable

(C800-6)

Macintosh to LCD 

Cable (C802-6)

Also included but not shown:



 • MAC to LCD Adapter (C804)

 • SGI to LCD Cable and Adapter (C943-6 and C947-12)

 • DEC 3C3 to LCD Cable and Adapter (C948-6 and C947-10)

 • MAC (C470-6) and PC (C936-6) Serial Cables (included with remote)

 • (2) AAA Alkaline Batteries

 • User's Guide

 • Product Registration Card

 • European (C1001-10), U.K. (C1004-10), and

   Italian (C1003-10) power cords




Composite

Video/Audio Cable


(C497-6)

S-Video Cable

(C466-6)

Computer Audio

Cable (C498-6)

Mini-jack to RCA 

Cable Adapter (C5105)

VOLUME

PROXIMA ®

MUTE

MENU

SETUP

SOURCE

PROG   2

PROG   1

–
+

13C3 to LCD Cable

(C801-6)

Cyclops F/X Disks

(A50 F/X)

Figure i-2, Items included with the Desktop Projector 9100
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i-4    Introduction

QUICK START

To connect the projector to your computer, read the section appropriate for
your hardware (or read Chapter 1, which lists these steps in greater detail).

Take a moment to familiarize yourself with the parts of the projector:

21

2

4

5

6

7

3

8

9

Figure i-3, The Desktop Projector 9100

NUMBER ITEM

1 control panel

2 arm release lever

3 flip mirror release lever

4 flip mirror

5 projection arm

6 power switch

7 connector panel

8 projection lens

9 projection window
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Introducing the DP9100    i-5

Step 1: Setting up the projector

1 Place the projector on a solid, flat surface.

2 Position the projector so that the side with the handle is facing the
projection screen.

3 Locate the arm release lever (see the next figure). Slide it gently in the
direction of the arrow.

Figure i-4, Pressing the lever to release the arm

4 The arm pops up. Gently lift the arm. It raises automatically until it is
fully extended. Do not force the arm further.
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i-6    Introduction

5 Locate the flip mirror release lever on the top of the arm (see Figure i-5).
Push it in the direction of the arrow  while pulling up on the lift tab. This
releases the flip mirror.

Figure i-5, Pressing the lever to release the flip mirror
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Introducing the DP9100    i-7

6 Gently tilt the mirror to approximately 45 degrees. (You can adjust the
angle later to raise or lower the projected image.)

Figure i-6, Flipping the mirror to a 45-degree angle

 CAUTION! Never push on or force the mirror. Always use care when
opening the mirror assembly. Avoid touching the surface of the mirror with
your fingers.
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i-8    Introduction

Step 2: Connecting the computer

In general, use the Proxima cable appropriate for your system to connect
your computer to the DP9100. Connect your computer's video out port to
the COMPUTER IN port on the projector. If you want to connect an external
monitor, use your existing monitor cable to connect the projector's
COMPUTER OUT port to your monitor.

MAC II

CPU

Monitor Adapter

(if needed)

Monitor Cable

To COMPUTER IN Port
Proxima Cable

Figure i-7, Connecting the projector to your computer

In some cases a Proxima adapter is required to connect your computer and
monitor to the projector. The adapters you'll need are included with your
projector. See Chapter 1, Setting Up Your Projector for more detailed
information on connecting your system.
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Introducing the DP9100    i-9

Step 3: Connecting video and audio

Connect audio and video sources to the projector, using this table as a
guide. If you need more information, see the appropriate section in
Chapter 2.

TO SET THIS UP: CONNECT THIS CABLE: FROM HERE: TO HERE:

Video from Composite audio/video cable VIDEO 1, 2 ports RCA port on VCR
VCR/ laserdisc (C497-6). on projector. marked “VIDEO OUT”

or something similar.

Video from S-Video S-Video cable (C466-6). S-Video 1, 2 ports Video Out port

 device on projector. on S-Video device.

Audio from Composite audio/video cable AUDIO IN 1, 2 Audio Out port
VCR/laserdisc (C497-6). ports on projector on VCR (red= right,

(red = right, white = left).

white = left).

Audio from computer Computer audio cable (C498-6). Left/right AUDIO OUT
COMPUTER port of the Mac
AUDIO IN ports or the sound card
on projector. of a PC.

External speakers Mini-jack to RCA cable adapter AUDIO OUT 1, 2 Mini-jack cable
(C5105) and mini-jack cable ports on included with speakers.

(included with speakers). projector.

Stereo system RCA stereo cable (comes with AUDIO OUT 1, 2 Left/right AUDIO IN
stereo). ports on ports on amplifier.

projector.

Microphone Microphone cable supplied with MIC port on Amplified microphone.
microphone. projector.

Step 4: Turning on the projector

Once you’ve connected your computer and any video or audio sources, turn
on the power:

1 Plug the power cord into the projector’s power receptacle. Plug the other
end into a properly grounded wall outlet or surge protector.

2 Move the POWER switch on the rear of the projector to the ON position.

3 Press the  key to ignite the lamp. The lamp will light slowly.

4 To raise or lower the image, tilt the flip mirror accordingly.

5 Rotate the ring at the base of the projector lens to focus the image.
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i-10    Introduction

THE CYCLOPS REMOTE CONTROL AND CONTROL
PANEL

2

3 5

7

8

3

5
12

11

34

313

9

VOLUME

PROXIMA®

MUTE

MENU

SETUPSOURCE

PROG   2PROG   1

– +

3 8

9

ll

10

1

2

5

6

74

SOURCEFIT-TO-VIEW™ CLEAR

SETUP

MENU

14

Figure i-8, The Cyclops remote control and control panel

KEY FUNCTION

1 MouseDisk •  Emulates a left-button mouse click when you press the center.

(remote only) •  Acts like an arrow key when you press the edges.

• Toggles between Draw and Move modes in the LightBoard™

   tool, and also controls the mouse pointer.

•  In MediaExpress menus, controls the mouse pointer.

2 Prog 1 Performs the function you define in the Preferences menu.

(remote only)

3 Source Cycles through the various input sources, including video,

computer, and MediaExpress mode.

4 /  (Lamp •  On the remote, press this key once to clear to a black screen.
on/off)    The lamp will stay on.

•  On both the remote and control panel,  turns the lamp

   off if you press it for more than two seconds. On the control

   panel, the green indicator light above this key illuminates when

   the lamp is on.
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Introducing the DP9100    i-11

KEY FUNCTION

5  (Volume +/-) Adjusts the audio level.

6 Mute (remote Mutes the audio, or returns the sound.

only)

7 Menu Turns the menus on and off.

8  Setup Adjusts the sync, contrast, brightness, tint, and image position

settings.

9 Fit-To-View/ •  In computer or video mode, the Fit-to-View key enlarges or

/Prog 2    compresses the image to fit the projector’s 1024 x 768

   resolution. To return the image to its original size, press this

   key again.

•  In MediaExpress mode, this key selects the current object.

•  Set the function of the Prog 2 key (remote only) in the

   Preferences menu.

10 Reverse/ •  In a MediaExpress presentation, Reverse/Forward move to

Forward/Pause    next/previous slide.

   ll •  Pause suspends the current slide in a MediaExpress

(remote only)    presentation.

•  Pause opens See-it/Show it in Cyclops F/X.

11  Replace •  Flashes for 90 seconds after turning off the lamp.

Lamp (control •  Illuminates when the recommended lamp life is exhausted.

panel only)

12  Overtemp Illuminates if the projector is too hot, or if the fans malfunction,

indicator indicating that the lamp was automatically turned off. If you

(control panel experience an overtemp condition, see Chapter 6, Troubleshooting

only) for more information.

13 Arrow keys •  Move right/left among menus; move up/down on menu items.

(control panel •  In MediaExpress presentations, right/left move to next/previous

only)    slide.

•  In MediaExpress menus, these keys navigate the menus.

•  Pans and positions the computer image.

14 Clear (control Clears the display to white, for use with overhead transparencies.

panel only) Clears the screen to black if you press it for two seconds.
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Chapter 1

Setting up your projector

OPENING THE PROJECTOR

To open the projector:

1 Place the projector on a solid, flat surface.

2 Position the projector so that the side with the handle is facing the
projection screen. The connector panel will be facing away from the
projection screen (see Figure 1-1).

Figure 1-1, Positioning the projector in front of the projection screen
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1-2    Chapter One

3 The projector must be parallel to the floor. If you’re using a media cart,
make sure the wheels are locked to prevent it from moving.

Perpendicular to the

projection screen

Parallel to the floor

Top View

Side View
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Figure 1-2, Top view and side view of the projector

4 Locate the arm release lever beside the control panel, on the top of the
projector (see Figure 1-3). Slide it gently in the direction of the arrow.

Figure 1-3, Pressing the lever to release the arm
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Setting Up Your Projector    1-3

5 The arm pops up. Gently lift the arm. It raises automatically until it is
fully extended. Do not force the arm further.

Figure 1-4, The arm pops up

6 Locate the flip mirror release lever on the top of the arm. Press it in the
direction of the arrow while pulling up on the lift tab. This releases the
mirror.

Figure 1-5, The flip mirror release lever
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1-4    Chapter One

7 Gently tilt the mirror open to approximately 45 degrees (you can adjust
the angle of the mirror later, to raise or lower the projected image).

Figure 1-6, Opening the flip mirror

 CAUTION! Never push on or force the mirror. Always use care when
opening the mirror assembly. Avoid touching the surface of the mirror with
your fingers.

Closing the projector

To close the projector, reverse the opening procedures.

1 Tilt the mirror down into the arm until it latches.

2 Gently swing the arm down until it clicks into place. The latch should
click when the arm is completely stowed.

Moving the projector

You should securely close the projector and disconnect all cables before
moving it. The projector has a recessed carrying handle on its side. To access
the handle, just push one side of it in, and the other side will automatically
release (see the next figure).
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Setting Up Your Projector    1-5

OVERTEMP

VOLUME

SOURCE

FIT-TO-VIEW

POWER

CLEAR

SETUP

MENU REPL   LAMP

Figure 1-7, Accessing the recessed handle

If you must move the projector while it is open, grasp it securely at the sides
by the lower part of the housing to support its weight.

Figure 1-8, Moving the projector while it is open

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



   
   

   
   

   
   

   
   

   
  

1-6    Chapter One

TURNING ON THE PROJECTOR

The projector and the external monitor (if you’re using one) should be
turned on before you turn on your computer. This ensures that the computer
properly senses the display during it’s start-up process.

On the rear panel of the projector there is a power cord receptacle and a
power switch.

Figure 1-9, The power switch

To turn on the projector:

1 Plug the power cord into the projector’s power receptacle.

2 Plug the other end of the power cord into a properly grounded electrical
outlet.

3 Move the POWER switch to the ON position.

4 Press the  key to turn on the lamp. The lamp will ignite slowly.

5 If you haven't already done so, connect the projector to your computer
and external monitor (if you're using one).

6 Turn on your computer and external monitor (if you’re using one).

You should see a projected image of your computer screen. You’ll see how to
focus the image shortly.

Note:  The DP9100 consumes 800 watts of power. Most circuits and surge
protectors support 1200 watts. Make sure to connect any peripheral
equipment to a separate circuit or surge protector.
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Setting Up Your Projector    1-7

CONNECTING THE PROJECTOR TO YOUR COMPUTER

Take a moment to review the projector’s connector panel.

Audio 1 In

Audio Out

MIC Cyclops

Computer 

Audio In

Audio 2 In

Video 1 S-Video 1

S-Video 2Video 2

Computer In Computer Out VGA Out

Figure 1-10, The connector panel

PORT CONNECTS TO... ...WITH THIS CABLE

AUDIO 1 In Left and right ports connect to Composite audio/video cable

AUDIO 2 In a video source, brings audio (C497-6).

into the projector.

VIDEO 1 Connects the projector to a Composite audio/video cable

VIDEO 2 video camera, laserdisc player, (C497-6).

television, or a VCR

(NTSC/ PAL/SECAM source)

to bring video from these

sources into the projector.

S-Video-1 Connects the projector to an S-Video cable (C466-6).

S-VIdeo-2 S-Video source to bring video

into the projector.

COMPUTER Left and right ports connect to Computer audio cable (C498-6) .

AUDIO IN the computer, brings audio

into the projector.

AUDIO OUT Connects to external speakers Audio cable.

or an external sound system to

send stereo audio out.

CYCLOPS* Connects to the computer to RS-232 cable (PC C936-6),

use the Cyclops F/X software (MAC C470-6), (Workstation C902-6

or the optional Cyclops and C903-6).

interactive pointer system.

* Instructions for connecting to this port are also included in the Cyclops
User’s Guide.
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1-8    Chapter One

PORT CONNECTS TO... ...WITH THIS CABLE

MIC Connects an external External microphone cable.

microphone to the projector.

COMPUTER Connects to the computer to PC: C800-6, Mac: C802-6, Sun: C801-6

IN bring computer video into the SGI: C943-6, DEC: C948-6.

projector.

COMPUTER Connects a workstation Existing monitor cable. You may also

OUT monitor to the projector for need to use an adapter.

simultaneous display.

VGA OUT Connects a PC or Macintosh Existing monitor cable. You may also

monitor to the projector for need to use an adapter.

simultaneous display.

To connect the DP9100 to virtually any PC, Macintosh, or workstation,
choose the Proxima cable(s) that matches your existing
computer-to-monitor connection.

You normally need only one Proxima cable. This cable is used to connect
the projector to your computer’s video output connector. Use the existing
computer-to-monitor cable if you also want to connect your monitor.

You can connect the computer-to-projector cable with the projector and
computer power on. Available cables include:

• 13C3 to LCD Connector Cable (C801-6)

• VGA to LCD Connector Cable (C800-6)

• Mac to LCD Connector Cable (C802-6)

• Mac to LCD Adapter (C804-0)

• SGI 13C3 to LCD Connector Cable (C943-6)

• SGI to LCD Adapter (C947-12)

• DEC 3C3 to LCD Connector Cable (C948-6)

• DEC 3C3 to LCD Adapter (C947-10)

• Optional BNC Block to LCD Connector Cable (C942-2)

• Optional BNC to LCD Connector Cable (C803-6)

Computer video always connects to the COMPUTER IN connector (13C3)
on the projector.
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Setting Up Your Projector    1-9

Audio In

Computer In

Figure 1-11, The projector’s COMPUTER IN connector

You can display data on a separate monitor in addition to the projector.
Computer out connections can be made with the projector and computer
power on.

Computer Out VGA Out

Figure 1-12, Projector’s video output connectors

Projecting without an attached monitor

Some display cards rely on sense line information from the monitor to
configure themselves for the correct display resolution. The absence of sense
line information causes some display cards to output a default video signal,
and actually prevents some video cards from outputting video at all.

If you connect the projector to a computer without a monitor, power up
your system and check to see if the display resolution is acceptable. If it is
not, you will need to set the sense lines to make the projector emulate a
monitor (see Appendix C: Sense Lines).
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1-10    Chapter One

PCs

1 Disconnect your computer-to-monitor cable at the computer end.

2 Connect the free end of the monitor cable to the VGA OUT connector on
the projector.

3 Use the Proxima VGA to LCD connector cable (C800-6) between the
projector and the computer. Connect the end of the cable marked “LCD”
to the projector’s COMPUTER IN connector, and the end marked
“COMPUTER” to the computer’s video output connector.

Proxima Cable

PROJECTOR

PC

Figure 1-13, PC video out connection to projector

Macintosh computers

Connecting a Macintosh monitor requires the Proxima VGA/MAC (C804)
adapter and the existing monitor cable. Use the Proxima adapter only.

1 Disconnect your computer-to-monitor cable at the computer end.

2 Connect the free end of the monitor cable to the Proxima VGA/MAC
adapter.
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Setting Up Your Projector    1-11

PROJECTOR

MACINTOSHProxima Cable

Figure 1-14, The Proxima Mac to LCD adapter

3 Connect the free end of the Mac to LCD adapter to the projector’s
VGA OUT connector.

Note:  Macintosh users who do not connect an external monitor may need to
set DP9100 sense lines to achieve the desired display resolution. See
Appendix C: Sense Lines for more information.

4 Use the Proxima MAC to LCD connector cable (C802-6) between the
projector and the computer. Connect the end marked “LCD” to the
projector’s COMPUTER IN connector, and the end marked “COMPUTER”
to the computer’s video output connector.

M
A

C

M
A

C
 M

o
n

it
o

r

LC
D

DP9100 

VGA OUT 


Port

Proxima Mac to LCD

Adapter

Existing MAC

Monitor Cable

Figure 1-15, The Proxima Mac to LCD Adapter
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Notebook computers

Use the appropriate Proxima video cable to connect your notebook to the
projector:

1 Connect the end of the Proxima video cable marked “COMPUTER” to the
external monitor connector on your notebook (or to the video cable
adapter supplied with your notebook).

2 Connect the end of the Proxima video cable marked “LCD” to the
COMPUTER IN connector on the projector.

Proxima CablePROJECTOR

NOTEBOOK

Figure 1-16, Notebook connections

Note:  Some notebooks require that you press a combination of keys or use
a control panel to set the projector as an external monitor. Refer to your
notebook manual for more information.
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Setting Up Your Projector    1-13

Workstations

13C3 Video Connections (except Silicon Graphics workstations)

If your workstation has a 13C3 connector at the computer video port:

1 Disconnect your computer-to-monitor cable at the computer end.

2 Connect the free end of the monitor cable to the projector’s COMPUTER
OUT connector.

3 Use the Proxima 13C3 to LCD Connector Cable (C801-6) between the
projector and the computer. Connect the end marked “LCD” to the
projector’s COMPUTER IN connector, and the end marked “COMPUTER”
to the computer’s video output connector.

Proxima Cable

Monitor Cable

Figure 1-17, Workstation video out connection to projector
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Silicon Graphics 13C3 Video Connections 

If you have a Silicon Graphics workstation with 13C3 connectors at the
computer and monitor video ports:

1 Disconnect your computer-to-monitor cable at the computer end.

2 Connect the free end of the monitor cable to the Proxima
SGI to LCD adapter (C947-12).

3 Connect the free end of the SGI to LCD adapter to the projector’s
COMPUTER OUT connector.

Note:  SGI workstation users who do not connect an external monitor will
need to set DP9100 sense lines to achieve the desired display resolution.
Refer to Appendix C: Sense Lines for more information.

4 Use the Proxima SGI 13C3 to LCD connector cable (C943-6) between the
projector and the computer. Connect the end marked “LCD” to the
projector’s COMPUTER IN connector, and the end marked “COMPUTER”
to the SGI workstation’s video output connector.

MAC II

CPU

SGI to LCD Adapter

Proxima SGI Cable

Monitor Cable

WORKSTATION




Figure 1-18, Silicon Graphics workstation connections

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



   
   

   
   

   
   

   
   

   
  

Setting Up Your Projector    1-15

DEC 3C3 Video Connections

If you have a DEC workstation with 3C3 connectors at the computer and
monitor video ports:

Figure 1-19, 3C3 connector

1 Disconnect your computer-to-monitor cable at the computer end.

2 Connect the free end of the monitor cable to the Proxima DEC 3C3 to
LCD adapter (C947-10).

3 Connect the free end of the DEC 3C3 to LCD adapter to the projector’s
COMPUTER OUT connector.

4 Use the Proxima DEC 3C3 to LCD connector cable (C948-6) between the
projector and the computer. Connect the end marked “LCD” to the
projector’s COMPUTER IN connector, and the end marked “COMPUTER”
to the workstation’s video output connector.

BNC Video Connections

If your workstation does not have a 13C3 video port connector at the
computer video port, but has a BNC connector at the monitor, you will need
the optional Proxima BNC cables.

1 Note which BNC connectors are currently used with the monitor. (The R,
G, and B connectors are always used, but the way the H and V connectors
are used depends on your configuration.) Disconnect your
computer-to-monitor cable at the monitor (BNC) end.

2 Connect the free BNC end to the optional Proxima BNC Block to LCD
Connector Cable (C942-2), connecting the same BNC connectors used
on the monitor. Plug the “LCD” end of the cable into the projector’s
COMPUTER IN connector.

Computer Video OutTo Projector

R

G

B

H

V

Figure 1-20, Using the BNC Block to LCD connector cable
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3 Connect the optional Proxima BNC to LCD Connector Cable
(C803-6) between the projector’s COMPUTER OUT connector and the
monitor’s BNC video input. Use the same BNC connections used with the
monitor.

13C3 t BNC C t C bl
Figure 1-21, BNC to LCD Connector cable

Connecting the Cyclops interactive pointer system

The Cyclops interactive pointer system uses a built-in camera to function
like a cordless mouse. With the Cyclops system, you can control your
computer's cursor by moving the hand-held wand or optional laser pointer.
Instructions for setting up your Cyclops system are included with your
Cyclops kit.

Connecting the MediaExpress system

The MediaExpress Image Display System is a hybrid, next-generation
product that brings the functionality of computers and projectors much
closer together.

The MediaExpress system eliminates the need to connect a computer to the
projector. Just save your presentation from whatever application you’re using
to a special kind of file (called a .PDF file), copy the file on a disk, then
place the disk in the MediaExpress disk drive and start the show.

To connect the MediaExpress system to the projector, see the Installation Card
that came with your MediaExpress package for instructions.
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CONNECTING VIDEO AND AUDIO TO THE PROJECTOR

This section shows how to connect audio and video to your projector. The
DP9100 has multiple inputs for audio and video. If you are connecting only
one audio or video source to your projector, use the VIDEO 1 and AUDIO 1
ports. Make sure that you connect your audio and video to the
corresponding group. If you connect video to group one and audio to group
two, you won’t hear the audio. Although both COMPUTER AUDIO IN and
AUDIO IN may be connected simultaneously, only one is active:

• If computer video is selected, COMPUTER AUDIO IN is active.

• If NTSC/PAL/SECAM/S-Video are selected, AUDIO 1 IN is active.

Connecting video from a VCR

The Desktop Projector 9100 can project video from NTSC, PAL or SECAM
sources (i.e., VCRs, laserdisc players and video cameras).

VIDEO RECORDER – VCR

VIDEO OUT
AUDIO OUT

Figure 1-22, The projector connected to a VCR
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The Composite Audio/Video cable (C497-6) has a yellow, red, and white
RCA plug at each end. To connect an NTSC, PAL, or SECAM source to your
projector:

CABLE PROJECTOR PORT VCR CONNECTOR
(C497-6)

Yellow VIDEO 1 or 2. Video Out, To Monitor, etc.

White AUDIO 1 or 2 IN (white plug). Left Audio Out.

Red AUDIO 1 or 2 IN (red plug). Right Audio Out.

Connecting video from S-Video sources

The Desktop Projector 9100 can also project video from an S-Video source.

1 Connect one end of the S-Video cable (C466-6) to the Video Out
connector on the video source. The cable has identical round four-pin
connectors on either end.

2 Connect the other end of the cable to the projector’s S-VIDEO 1 port.

Connecting audio from the computer

Use the COMPUTER AUDIO IN port to connect audio from a computer.

1 Insert the mini jack end of the computer audio cable (C498-6) into the
AUDIO OUT connector of a Macintosh or the sound card of a PC.

2 Insert the RCA jacks at the other end of the computer audio cable into the
projector’s left and right COMPUTER AUDIO IN ports.

AComputer 

Audio In

Figure 1-23, Connecting audio from the computer

Connecting a microphone

To use a microphone while projecting an NTSC, PAL, SECAM, S-Video, or
computer image, plug an amplified or wireless microphone equipped with a
line level output (maximum 1 volt, peak-to-peak) into the MIC port.
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Connecting external speakers

The Desktop Projector 9100 contains an internal stereo system consisting of
an amplifier and two speakers. Although this system provides high-quality
stereo output, a multimedia presentation may require external powered
speakers or an external sound system.  

When connecting external speakers, use the optional Proxima Powered
Loudspeaker System (A55) or a similar system. References in the following
procedure are to Figure 1-24.

1 Insert the two RCA plugs on the Mini-jack to RCA cable adapter (C5105)
into the projector’s AUDIO OUT ports.

2 Connect the other end of the Mini-jack to RCA cable adapter (C5105) to
the speaker cable (included with your speakers).

3 Connect speaker A to speaker B using the cables supplied with the
speaker system.

Mini-jack to RCA

Cable Adapter

Figure 1-24, Connecting external speakers
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Connecting an external stereo system

To connect the projector to an external stereo system:

1 Using the Composite Video/Audio cable (C497-6), insert the white and
red RCA plugs into the projector’s left and right AUDIO OUT ports.

2 Insert the white and red RCA plugs at the other end of the cable into the
external amplifier’s left and right AUDIO IN ports.

Stereo Receiver







Figure 1-25, Connecting an external stereo system
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IMPORTANT PRECAUTIONS

To avoid any potential hazards to the projector, make sure the air intake and
exhaust grills are unobstructed. Do not operate the projector if these areas
are clogged or blocked.

Figure 1-26, Allow sufficient air flow

 CAUTION! The lamp chamber gets very hot during operation, especially
the ceramic sockets at each end of the lamp. Be very careful when opening
the lamp chamber or changing the lamp. To allow that area to cool down,
press the  key to turn off the lamp and let the fan cool the projector for at
least five minutes before you touch any of those components. See Chapter 5,
Maintenance, for more information.
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Turning the lamp on and off

The lamp is off when you first turn on the projector. Press the  key on the
on the Cyclops remote control or control panel to turn the lamp on. The
green power indicator light illuminates. It takes a few seconds for the lamp to
warm up.

VOLUME

MUTE

MENU

SETUPSOURCE

PROG   2PROG   1

– +

FIT-TO-VIEW™

Figure 1-27, The  key

To turn the lamp off, press and hold the  key for about two seconds. When
you turn the lamp off, the projector’s fans will continue to run for about two
minutes. Allow the fans to run until they automatically turn off. This will
lengthen the lamp life and help ensure that the projector cools properly.
Turning the lamp off does not turn off the projector. To turn the power off,
move the power switch on the back of the projector to the OFF position.

After you turn off the lamp, you can immediately turn it back on within five
seconds. If you wait longer than five seconds, you must then wait 90 seconds
before turning it back on. This is a built-in feature that helps to prevent
lamp damage. Press the  key again to turn the lamp back on. The lamp
illuminates slowly in order to prolong lamp life.

The projector has safeguards built in to protect it from overheating. In the
rare event that the projector overheats, the lamp will turn off automatically
and the overtemp indicator on the Control Panel will illuminate.

FIT-TO-VIEW™

Figure 1-28, The overtemp indicator light
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In the unlikely event that an overtemperature conditions occurs, see
Chapter 6, Troubleshooting for information on restarting your projector.

ADJUSTING THE IMAGE

Raising or lowering the image

To raise or lower the projected image, tilt the mirror on top of the arm up
(to move the image higher) or down (to move the image lower).

Focusing the image

To focus the image, rotate the ring just below the projection lens, beneath
the mirror, until the image is sharp and clear.

Figure 1-29, Rotating the focus ring
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Correcting keystoning

The normal projected image will have a rectangular shape. An image is
keystoned when it appears trapezoidal.

Figure 1-30, Normal image vs. keystoned image

Keystoning occurs when the front of the projector is not perpendicular to
the projection screen (the vertical plane) or when the projector is not
parallel to the floor (the horizontal plane). Keystoning can also occur when
the projector is tilted sideways.

To correct keystoning, make sure that the projector is at a right angle to the
projection screen in the horizontal plane (see Figure 1-30).

To project images high enough for the entire audience to view, the DP9100
has a built-in 4.5-degree correction for keystoning.

Image size

The size of the projected image depends on the distance between the
projector lens and the projection screen. This table shows the projected
image size, measured diagonally, based on this distance.

DISTANCE FROM SCREEN DIAGONAL IMAGE SIZE

4 ft/1.2 m 46 inches

6 ft/1.8 m 69 inches

8 ft/2.4 m 92 inches

10 ft/3.0 m 115 inches

12 ft/3.6 m 138 inches
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Chapter 2

Using your projector

The Desktop Projector 9100 was designed with ease of use and simplicity in
mind. With the Cyclops remote control or the control panel, most of the
common functions are right at your fingertips.

To perform most of the actions you’ll need during your presentation, such as
adjusting or muting the volume and proceeding from one slide to the next,
just press a button on the Cyclops remote control or the control panel.

This chapter describes keys on the Cyclops remote control and control panel
and their associated functions. It also describes how to use the various
projector and menu settings.

USING THE CYCLOPS REMOTE CONTROL AND
CONTROL PANEL

VOLUME

PROXIMA®

MUTE

MENU

SETUPSOURCE

PROG   2PROG   1

– +

SOURCEFIT-TO-VIEW™ CLEAR

SETUP

MENU

Figure 2-1, The keys on the remote control and control panel
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Source key

Use the Source key to switch between the various video input sources you
connect, such as the computer video input, NTSC/PAL/SECAM video input,
S-Video input, or MediaExpress input.

Setup key

Use the Setup key to make your pre-presentation adjustments, such as sync,
brightness, contrast, tint, and image position.

 (Volume)

Use the Volume keys to adjust the volume from the projector’s internal
speakers and any connected external speakers.

Prog 1 and Prog 2 keys

Use these keys to perform the function you define in the Preferences menu.
In the MediaExpress dialog boxes, the Prog 2 key selects the highlighted
item.

Reverse/Forward/Pause

In a MediaExpress presentation, these keys reverse or advance to the next
slide. The Pause key suspends the timer for a slide during a MediaExpress
presentation. It also opens See-it/Show-it in Cyclops F/X.

MouseDisk

When you press the center of the MouseDisk, it acts like a mouse click.
When you press the edges of the MouseDisk, it acts like an arrow key.

In the LightBoard tool, this key toggles between Draw and Move modes. It
also controls the mouse pointer. In MediaExpress dialog boxes, press the
edges of this button to move the mouse pointer, and the center to select
options.

Mute

Use the Mute key to turn off the sound from the internal or external
speakers. Press it again to return the sound.
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Menu

Press the Menu key to activate the onscreen menus. Press it again to exit the
menus.

/  (Lamp on/off)

This key turns the lamp on and off. On the remote, press and release this
key once quickly to display a black screen. To turn the lamp off, press and
hold this key for at least two seconds. This key does NOT turn off the
projector.

Arrow keys (control panel only)

When the projector menus are displayed, the arrow keys on the Control
Panel move the mouse pointer from menu to menu (up and down arrow)
and to items on the current menu (left and right arrow).

When the projector menus are not displayed, these keys pan or position the
image in computer or video mode.

When the MediaExpress menus are displayed, these keys navigate those
menus and dialog boxes.

Fit-To-View/  (MediaExpress) 

The Fit-To-View key enables you to fit a projected image on the screen while
your system displays at a higher resolution. Press this key to intelligently
scale images larger than 1024 x 768 or to enlarge 640 x 480 images. Press
this key a second time to return to the normal display.

In MediaExpress mode, this button has multiple functions. See your
MediaExpress User's Guide for more information.

Clear

Press the Clear key to clear the screen to a bright white background. This is
especially useful when you want to show a transparency during your
presentation. Press and hold the Clear key for about two seconds to clear the
screen to black. To redisplay video, press the Clear key again.
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 (Overtemp indicator light)
This light illuminates if the projector becomes too hot or when one of the
fans malfunctions. When this light is illuminated, the lamp automatically
turns off. In the unlikely event of an overtemperature condition, see
Chapter 6, Troubleshooting for more information.

 (Lamp indicator light)
This light illuminates when the lamp needs to be replaced. It also flashes for
about 90 seconds after you turn off the lamp.

SWITCHING BETWEEN INPUT SOURCES

With some presentations, you’ll have multiple input sources connected to
the projector. Input sources are VCRs, computers, laserdisc players, the
optional MediaExpress system, or any piece of hardware that produces
images that you want to project through your projector. For example, you
may have a VCR, the MediaExpress system, and your computer connected.

To switch between sources, just press the Source key. The Source key cycles
through the various sources that are currently connected to your projector.

USING THE MENUS

Before starting your presentation, you’ll want to fine-tune the image to get
the sharpest, clearest image possible. The handful of settings you’ll use the
most are very easy to access. Just press the Setup key and make your
adjustments. For the settings you use less frequently, access the projector’s
menus to make your adjustments. To open the menus, press the Menu
button once.

Each menu command offers a list of related settings. Each setting is
described in Chapter 3. For now, it’s important to know how to choose a
menu and adjust the various settings.

To navigate through the menus, press the edges of the MouseDisk on the
remote control or use the optional Cyclops wand or laser pointer. (On the
projector's control panel, press the up and down arrow keys.) As the cursor
moves up and down the main menu, additional options appear to the right.
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For most settings, you make incremental adjustments by moving a slide bar.
To move a slide bar, press the edges of the MouseDisk, press the up and
down arrow keys on the projector’s control panel, or use the optional
Cyclops wand or laser pointer.

Changing the language on the menus

To change the menus to a different language, choose Language on the
Preferences menu. Then choose the language you prefer. You can select
between English, Spanish, French, German, and Italian. The menus instantly
change to the language you selected.

Saving your settings

Your current settings are saved when you exit the menus. Your settings will
also be saved if you hold the  key for two seconds (to turn off the lamp).

If two or more presenters want to save their settings separately, see Advanced
Features.

Reverting to the factory defaults

If you want to revert to the original factory settings for a specific computer
source, choose Image, Factory Defaults, Reset.

To reset the projector itself , press the Clear key, then press each of the four
arrow keys on the projector’s control panel once. The power LED indicator
will blink twice to indicate the projector has been reset.

ADJUSTING THE IMAGE

Press the Setup key to access most of the settings you need to adjust the
image.

Note: The choices on the Setup menu vary, depending on your current input
source.

Adjusting the brightness

To adjust the brightness, press the Setup key until the Brightness slider
appears. Press the edges of the MouseDisk, use the optional Cyclops wand
or laser pointer, or press the left and right arrow keys to move the slider.

You can also adjust the brightness by accessing the projector menus and
choosing Bright from the Image menu.
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Adjusting the contrast

To adjust the contrast, press the Setup key until the Contrast slider appears.
Press the edges of the MouseDisk, use the optional Cyclops wand or laser
pointer, or press the left and right arrow keys to move the slider.

You can also adjust the contrast by accessing the projector’s menus and
choosing Contrast from the Image menu.

Correcting shimmering or streaks

If your projected image has horizontal streaks, or seems to “shimmer”
slightly, adjust the Sync setting. (This setting is only active when the source
is your computer.)

Press the Setup key until the Sync slider appears. Press the edges of the
MouseDisk, use the optional Cyclops wand or laser pointer, or press the left
and right arrow keys to move the slider. Repeat until the streaks are gone.

You can also adjust the sync by accessing the projector’s menus and
choosing Sync from the Image menu.

Correcting vertical banding

If the projected image has vertical black lines or bands, adjust the Dot Clock
setting on the Image menu to eliminate them. Adjust the slider so that the
bands get wider. Continue to adjust the slider until the bands disappear.
(This setting is only available when the source is your computer.)

Adjusting the color tint and saturation

To correct the tint, press the Setup key and adjust the slide bar for the Tint
setting (availability depends on your current input source).

If you prefer, you can also adjust the Red, Green and Blue settings on the
Image menu (while the computer or the MediaExpress system is the input
source) or the Tint setting (while video or S-Video is the input source).

Adjusting image position

To move the onscreen image, use the arrow keys on the control panel or
press the Setup key and adjust the slide bar for Hor. Pos (Horizontal
Position) or Vert. Pos. (Vertical Position). These settings can also be found
on the Advanced menu.
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Switching to rear projection mode

To switch to rear projection mode (projecting from behind the projection
screen instead of in front of the screen), choose Projection, Rear from the
Projector menu.

ADJUSTING THE AUDIO

You can adjust the volume from the Cyclops remote control, the control
panel, or the menus. The Audio menu contains additional audio controls.

Displaying and hiding the volume indicator

You can display a volume indicator while you increase or decrease the
volume of the internal  speakers. To display the volume indicator, choose
Preferences, Onscreen, Display. To suppress this visual indicator, set
Onscreen to Hide.

Adjusting the volume

To adjust the volume of the internal speakers and any external speakers
you’ve connected, press the plus (+) or minus (–) Volume key on the remote
or control panel. You can also make your adjustments through the Audio
menu.

Muting the audio

To mute the audio, press the Mute key on the remote, or choose Mute from
the Audio menu.

To turn the sound back on, press the Mute key a second time or choose
Mute, Normal from the Audio menu.

Adjusting bass and treble

To adjust the level of bass or treble, choose the corresponding command on
the Audio menu, then move the slide bar in the appropriate direction.
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Adjusting fade and balance

The fade slider allows you to choose between the projector's internal
speakers and an external loudspeaker system like the Proxima Powered
Loudspeaker System (A55). The balance slider allows you to control the
level of sound between the left and right sides of your sound system.

To adjust the fade and balance, choose the corresponding command on the
Audio menu, then move the slide bar in the appropriate direction.

Adjusting the volume of the microphone

To increase or decrease the volume of the microphone, choose Mic. Volume
from the Audio menu, then move the slide bar in the appropriate direction.

Switching between stereo and monaural mode

To switch between stereo and monaural mode, choose Audio Mode from
the Audio menu, then choose the appropriate setting.

ADJUSTING REMOTE MOUSE TRACKING

Use this setting to adjust how fast the pointer moves. To increase or decrease
the remote mouse tracking, choose Mouse Tracking from the Tools menu
and move the slider in the appropriate direction.

PRESENTATION FEATURES

Once you’ve adjusted the image and audio settings, you’re ready to start
your presentation. This section describes some of the features of the DP9100
that you’ll want to use during your presentations.

Using the LightBoard tool

The LightBoard™ tool is a unique feature that lets you draw on or annotate a
projected image. You can choose from three styles:

• Overlay lets you highlight or draw on top of the projected image.

• WhiteBoard clears the screen to provide a bright background for drawing.

• BlackBoard clears the screen to provide a dark background for drawing.

To use the LightBoard tool:

1 Open the menus and choose Tools.
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2 From the Tools menu, choose LightBoard mode, then specify whether
you want the Overlay, WhiteBoard, or BlackBoard.

3 From the Tools menu, choose LightBoard, On. The Draw toolbar appears
in the upper left corner of the projected image. It has four buttons:

Figure 2-2, The Draw toolbar

BUTTON FUNCTION

Click this button to select the Drawing tool.

Click this button to select the Eraser. You can erase any of your

annotations.

Click the Clear All button to erase all previous annotations.

Click this button to select a new color. This button shows the
currently selected color.

Note:  If you're using the optional Cyclops interactive pointer system, you
can also click above the image to activate the LightBoard tool.
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4 Select one of these buttons, then use the Cyclops wand, laser pointer, or
the MouseDisk to draw on the projected image.

To open the color palette:

1 Click the Color box or the icon in the upper right corner of the projected
image. Eight color selection boxes appear.

Figure 2-3, The Color selection boxes

2 Click the color you want to use, then click the Color box or icon again to
hide the color selection boxes.

To draw, click and hold the MouseDisk for about two seconds, then release.
Use the edges of the MouseDisk to draw on the screen. When you are in
draw mode, the cursor will be black. When you are in move mode, the
cursor will be white.

To draw with the optional Cyclops interactive pointer system, click and hold
the wand button while you move the cursor around the screen. Release the
button to end the drawing.

You can move the Draw toolbar to another spot on the projected image. Just
click and hold the title bar of the toolbar, drag it to a new location, and
release the button. See Programming the Cyclops remote control on page 2-12
for more information.

When you finish using the LightBoard tool, click the close box in the upper
left corner of the Draw toolbar.
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If you find that you use LightBoard features frequently, consider
programming either the Prog 1 or Prog 2 key, so you can access the
LightBoard tool with the press of a key.

Setting the timer (for audience intermission)

The DP9100 includes a break timer, for lunch breaks, intermissions,
question and answer sessions, or any other timed pause. Your audience will
see a “countdown” of the number of minutes remaining.

To use the timer, first set the length of the break. Choose Tools, Break Timer
Value, then indicate the length of the break, in minutes. You can set a break
in increments up to one hour.

After you indicate the length of the break, choose Tools, Break Timer, On to
start the timer. To turn the Break Timer off, press the Menu key on the
remote or control panel.

Projecting transparencies

The Clear key clears the projected image, allowing you to project
transparencies in the middle of your presentation.

You can clear to either a white or black background. Press the Clear key once
quickly to clear to a white background. Press and hold it for at least two
seconds to clear to a black background. Press Clear again once quickly, to
return the projected image.

Note: The panel area on the DP9100 is 6” by 8”, which is slightly smaller
than the panel area of most overhead projectors (typically 8.5” x 11”). You
will need to adjust the focus to display transparencies.

Using the Fit-To-View feature to zoom, reduce
and pan images

The Fit-To-View feature lets you fit larger images on one screen. Use this key
to compress 1280 x 1024 or 1152 x 900 images to fit the 1024 x 768 screen
resolution, or to enlarge a 640 x 480 image to fit the screen. Press the
Fit-To-View key a second time to return the image to its original size.

To pan an image that does not fit on the screen (images larger than
1024 x 768), press the arrow keys on the projector’s control panel.

Note: You can set the top and left pan limits by adjusting the Advanced,
Horizontal (and Vertical) settings in the projector menus.
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Cyclops F/X

Your projector comes with Cyclops F/X—software effects that you can use to
make your presentations more interesting and effective. For more
information on Cyclops F/X, see Chapter 4, Cyclops F/X.

ADVANCED FEATURES

There are several advanced features of the DP9100 that make giving
presentations even easier. For example, you can program two keys on the
remote control, assigning them specific options. You can also save setting
profiles, allowing two presenters who use the same projector to save their
custom settings.

Programming the Cyclops remote control

You can program two keys on the Cyclops remote control, the Prog 1 and
Prog 2 keys, to perform commonly used actions or to access a setting that
you frequently adjust.

To program the Prog 1 and 2 keys, open the projector menus and choose
Preferences. Choose the key you want to program (Prog 1 or Prog 2) and
assign the feature or setting you want to access.

Note: If you want to set assign one of the Cyclops F/X effects to one of the
programmable keys, you must select Host in the Preferences menu.

Saving a user profile

Different presenters have different styles. The DP9100 offers a way for two
presenters to save their settings and recall them each time they give a
presentation.

To save the current video settings as a profile, open the projector menus and
choose Advanced, User. Choose User A or User B, adjusting each setting
you want to save. When you exit the projector menus, your settings will be
saved as the profile.

Note:  Sense line and front/rear settings are not saved as part of the profile.
Sense line settings are automatically set when you turn on the monitor that is
connected to the projector.

When you want to use your profile, open the projector menus and choose
User, Advanced, then select your profile (User A or User B). The settings take
effect immediately.
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Chapter 3

Menus and keys

PROJECTOR MENUS

The Main menu
Menus

Input Source

Cyclops

Advanced

Image

Projector

Tools

Audio

Preferences

Figure 3-1, The Main menu

MENU WHAT IT CONTAINS

Tools Settings for the LightBoard tool, Break Timer, and mouse tracking.

Cyclops Commands for calibrating the Cyclops interactive pointer system

and button selection.

Input Source Settings for computer, video, S-Video, and MediaExpress input

sources, and a display-only screen of current VSync, HSync, Lines,

and Sense measurements.

Image Settings for brightness, sync, tint, saturation, contrast, color, dot

clock, and interlace assignment.

Audio Settings for volume, mute, balance, bass, treble, fade, microphone

volume, and mono/stereo mode.

Projector Settings for front/rear projection and the lamp hours counter.

Preferences Settings for colors, language, onscreen indicators, and Program

key functionality. Also contains the settings for projecting in

reverse video for DOS screens.

Advanced Settings for custom profiles, horizontal and vertical image

position, VCO gain, and sense lines.
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The Tools menu

LightBoard Mode LightBoard

WhiteBoard On

BlackBoard

Overlay Off

Break Timer

On

Off

Break Timer 

Value

15:00

Mouse

Tracking

Menus

Input Source

Cyclops

Advanced

Image

Projector

Tools

Audio

Preferences

Figure 3-2, The Tools menu

USE THIS ...TO DO THIS:
OPTION...

LightBoard Mode Sets the background for LightBoard drawing:

•  Overlay (transparent)

•  WhiteBoard (white background)

•  BlackBoard (black background)

LightBoard Turns the LightBoard tool on and off.

Break Timer Starts the timer or turns it off.

Break Timer Value Sets the break timer interval, from 1 - 60 minutes.

Mouse Tracking Sets the speed of the mouse.
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The Cyclops menu

Calibrate Button

Calibrate Right

None

No Calibrate Left

Center

Menus

Input Source

Tools

Advanced

Image

Projector

Cyclops

Audio

Preferences

Figure 3-3, The Cyclops menu

USE THIS ...TO DO THIS:
OPTION...

Calibrate Starts the Cyclops calibration procedure.

Button Sets the Cyclops wand or laser pointer to emulate a left, right, or

center mouse button (or none).
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The Input Source menu

Source Select SourceMode Input Measurements

Video 1 EWS1 (140 MHz) HSync:  0.00 KHz

Current Mode:

S-Video 1

Computer VSync:  0.00 Hz

Lines: 0 Sense: HHHH

�

Video 2

S-Video 2

SelectCancel

EWS2 (130 MHz)



EWS3 (135 MHz)







1280 x 1024 81.25 KHz 76 Hz

1280 x 1024 81.97 KHz 76 HZ




1280 x 1024 80 KHz 76 Hz

Menus

Cyclops

Tools

Advanced

Image

Projector

Input Source

Audio

Preferences

MediaExpress

Figure 3-4, The Input source menu

USE THIS ...TO DO THIS:
OPTION...

Source Select Select the input source:

•  Computer

•  Video 1

•  S-Video 1

•  Video 2

•  S-Video 2

•  MediaExpress (optional)

Source Mode Select from a list of video or computer standards:

•  NTSC

•  PAL

•  SECAM

•  Computer compatibility

Input View projector readings for the selected input source:

Measurements •  VSync (vertical sync frequency)

•  HSync (horizontal sync frequency)

•  Lines (number of h-sync pulses per v-sync)

•  Sense (monitor input sense line levels)
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The Image menu (computer or MediaExpress input
source)

Figure 3-5, The Image menu

USE THIS ...TO DO THIS:
OPTION...

*Sync Adjusts the sync setting.

*DotClk Adjusts the dot clock setting.

Bright Adjusts the brightness of the image.

Contrast Adjusts the RGB bias levels.

Red Adjusts the red level.

Green Adjusts the green level.

Blue Adjusts the blue level.

*Factory Default Resets the source mode to the initial factory settings.

Interlace Sets the interlace even/odd frame assignment:

•  Even sets frame 0 as even.

•  Odd sets frame 0 as odd.

* Not available in MediaExpress mode.

Bright ContrastSync DotClk.Menus

Cyclops

Tools

Advanced

Input Source

Projector

Image

Audio

Preferences

Green BlueRed Factory 

Default

Reset

No Reset

Interlace

Odd

Even
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The Image menu (video or S-Video input source)

BrightContrastMenus

Cyclops

Tools

Advanced

Input Source

Projector

Image

Audio

Preferences

SaturationTint

Figure 3-6, The Image menu

USE THIS ...TO DO THIS:
OPTION...

Contrast Adjusts the video contrast.

Bright Adjusts the video brightness.

Tint Adjusts the video tint.

Saturation Adjusts the video color saturation.
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The Audio menu

Figure 3-7, The Audio menu

USE THIS ...TO DO THIS:
OPTION...

Volume Adjusts the audio volume.

Mute Mutes the audio or turns it back on.

Balance Adjusts the left/right audio balance.

Bass Adjusts the bass.

Treble Adjusts the treble.

Fade Adjusts front/rear audio balance.

Mic. Volume Adjusts the volume of the microphone.

Audio Mode Switches between Stereo and Mono mode.

Balance BassVolumeMenus

Cyclops

Tools

Advanced

Input Source

Projector

Audio

Image

Preferences

Fade Mic.

Volume

Treble Audio

Mode

Mono

Stereo

Mute

Mute

Normal
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The Projector menu

Projection Lamp Hours Lamp Hours

Rear Reset

Front No Reset 65:25:54

Menus

Cyclops

Tools

Advanced

Input Source

Audio

Projector

Image

Preferences

Figure 3-8, The Projector menu

USE THIS ...TO DO THIS:
OPTION...

Projection Switches between front and rear projection.

Lamp Hours Resets the lamp hours counter. Use this option after you change

the lamp.

Lamp Hours Displays the number of hours elapsed on the lamp hours counter.
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The Preferences menu

Figure 3-9, The Preferences menu

USE THIS ...TO DO THIS:
OPTION...

Colors Sets the number of colors to use.

Language Sets the default language for the menus.

On-screen Displays or hides the slide bars for sync, volume, contrast, tint,

horizontal position, and vertical position.

Prog 1 Sets an operation for the Prog 1 key on the remote control.

Choose from the following options (described elsewhere in this

guide):

•  Fit-to-View

•  LightBoard

•  Reverse

•  Clear

•  Freeze

•  Colors

•  WhiteBoard

•  BlackBoard

•  Host

•  Title screen

Prog 2 Sets an operation for the Prog 2 key on the remote control (same

choices as Prog 1 key).

Language

Deutsch

Francais

English

Español

Italiano

Prog. Key1

LightBoard

Fit-to-View

Reverse

Freeze

Clear

Menus

Cyclops

Tools

Advanced

Input Source

Audio

Preferences

Image

Projector

Colors

Millions

226K

On-Screen

Hide

Display

Prog. Key2

Fit-toView

LightBoard

Reverse

Freeze

Clear
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The Advanced menu

Figure 3-10, The Advanced menu

USE THIS ...TO DO THIS:
OPTION...

User Sets a user profile of projector settings:

•  Defaults

•  User A (user defined)

•  User B (user defined)

Hor. (Horizontal) Adjusts the horizontal position of the image on the screen.

Pos (Position)

Vert. (Vertical) Adjust the vertical position of the image on the screen.

Pos (Position)

VCO gain Sets the VCO gain parameter of the PLL.

Sense 3, 2, Set the level of the four sense pins:

1, and 0 •  High does not drive this pin.

•  Low drives the pin low.

See Appendix C, Sense Lines for more information.

User

User A

User B

Defaults

Sense 3

Low

High

Horiz.

Pos.

Menus

Cyclops

Tools

Preferences

Input Source

Audio

Advanced

Image

Projector

Vert.

Pos.

VCO

Gain

Sense 2

Low

High

Sense 1

Low

High

Sense 0

Low

High
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Chapter 4

Cyclops F/X

Your projector comes with Cyclops F/X — software effects that you can use
to make your presentations more interesting and effective. For example, you
can use the Spotlight to call attention to specific areas on the image, use the
Zoom or Magnify effects to focus on important information in the image, or
use See-it/Show-it to preview images on your computer without distracting
your audience.

You can use Cyclops F/X with either the r emote that came with your

projector or the optional Cyclops interactive pointer system, or both a

same time.

Note: Cyclops F/X is not available for UNIX systems.

Note: You cannot use Cyclops F/X with the MediaExpress system.

To use Cyclops F/X, follow these steps (details are covered throughout this
chapter):

1 Use the serial cable appropriate for your system (PCs: C936-6 or Macs:
C470-6) to connect the serial port on your computer to the CYCLOPS
port on the projector.

C Cyclops

Figure 4-1, Cyclops port on the projector

2 Install the Cyclops F/X software.

3 Start Cyclops F/X, customize the effects, and assign them to specific keys
on the keyboard or buttons on the remote control.

4 Minimize the Cyclops F/X main screen.

Then, just press the assigned key or button during your presentation to start
an effect.

This chapter is designed to give you a brief intr oduction to the

Cyclops F/X softwar e.

Note:  Updates to the Cyclops F/X software are available for download from
the World Wide Web at http://www.prxm.com.
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INSTALLING CYCLOPS F/X

Follow these steps to install the Cyclops F/X software:

1 Insert the disk labeled Proxima Cyclops F/X into your computer's floppy
drive.

2 Do one of the following:

• In Windows 95, choose Start, Run, then type a:\setup.exe
(or the drive letter for your floppy drive).

• In Windows 3.x, choose File, Run, then type a:\setup.exe
(or the drive letter for your floppy drive).

• On a Macintosh, double-click the disk icon, then double-click the
Cyclops F/X Installer icon in the disk window. Drag the Cyclops F/X
icon onto the hard disk icon.

3 Follow the instructions that appear on your screen.

STARTING CYCLOPS F/X

Once you’re finished with the installation, do one of the following:

• In Windows 3.x or Windows 95, double-click the Cyclops F/X icon to
start the program.

• For Macintosh users, the software will automatically load each time you
start your computer.

Windows users

The first time you start the software, Cyclops F/X displays a Projector Setup
Tutorial (Wizard). Follow the instructions that appear on your screen. When
you have finished configuring your system, restart Windows.
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The main screen of the F/X program appears:

Figure 4-2, Cyclops F/X special effects

On the left side of this window is a list of the special effects. The
Assignments area in the middle of the window provides options that allow
you to customize your remote and software.

Note:  If you open a menu, or if you're using the LightBoard tool, Cyclops
F/X will be suspended.

ASSIGNMENTS AREA

The Assignments area displays the custom remote keys and their current
assignments. To modify the custom remote keys:

1 Highlight the effect you want to assign.

2 Double-click the box next to the custom remote key in the Assignments
area.
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 The Assignments area also contains five buttons:

BUTTON FUNCTION

Setup Remote Lets you switch the assignments display between the included

Cyclops remote control and the optional Cyclops wand or laser

pointer.

Put Away Minimizes the F/X screen.

Edit Effect Allows you to assign a shortcut key to the effect. You can also use

this option to customize an effect.

Projector Setting Allows you to adjust image, audio, and general settings on your

projector.

Connect Allows you to choose the COM port to which you will connect

your projector.

In addition, the Assignments area allows you to control the MouseDisk
speed on your remote, and gives you checkboxes to turn on audible and
visual feedback.

CUSTOMIZING EFFECTS

Most effects have options that you can tailor to both the presentation and
your own presentation style.

For example, you can customize the Spotlight effect to specify the shape and
size of the spotlight. You can also change the name of each effect (for
example, you can change the name from “Spotlight” to “Headlight”).

You can assign each effect to a key on the keyboard or a button on the
remote control. The key or button you choose starts that effect.

To customize an effect:

1 Right-click the name of the effect and choose Edit from the menu. You
can also select the desired effect and click the Edit Effect button to make
your changes.

2 Adjust the settings in the appropriate dialog box and click OK.

3 When you’re finished customizing the effect, choose File and Save to save
your settings.

4 Click the control box in the upper right corner to minimize the Cyclops
F/X main screen.
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Note:  To access effects that are assigned to the Prog 1 and Prog 2 keys,
assign the settings for those keys (in the projector's Preferences menu) to
Host.

USING THE CYCLOPS INTERACTIVE POINTER SYSTEM

You can use the Cyclops interactive pointer system with Cyclops F/X. To set
up the software, click Setup Remote in the Assignments area of the mains
screen. Choose Cyclops Wand or Laser Pointer. The following screen
appears:

Figure 4-3, Cyclops interactive pointer screen

Click the Show Navigation Bar checkbox to enable the navigation bar. This
will provide you with a quick way to scroll through your slide show with the
Cyclops wand or laser pointer.
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Click on the Edit Navigation Bar button. The following screen appears:

Figure 4-4, Edit Cyclops Navigation screen

Use this screen to assign different options to the navigation bar. To assign a
new function to the navigation bar, click the Next or Previous areas and
assign a function using the list boxes to the right.

You can also use this screen to define where the navigation bar will appear
on your display. The default is Lower Left.
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SEE-IT/SHOW-IT

See-it/Show-it is a feature of Cyclops F/X that previews the next slide in your
presentation on your computer monitor—without switching from the slide
your audience sees. The See-it/Show-it feature displays the image, along with
a timer that counts down on your computer monitor until See-it/Show-it
displays the next slide. You can use See-it/Show-it to preview slides so that
you can interact with your audience, while preparing for the message on the
next slide.

To use See-it/Show-it:

1 Click Edit Navigation Keys in the Assignments area of the Cyclops F/X
main screen. The following screen appears:

Figure 4-5, Edit Navigation Keys screen

2 Select a countdown time for the Forward or Reverse keys, or both. When
you select a countdown time, See-it/Show-it is automatically enabled.

3 To disable See-it/Show-it, select None from the Forward and Reverse key
list boxes.

To switch to See-it/Show-it, press the Forward or Reverse key once quickly.
To end See-it/Show-it, press the Forward or Reverse key a second time. The
counter disappears and the next slide immediately displays.
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FREEZE

The Freeze option freezes the image on your projector so you can use your
remote to control your computer. This might be handy when you want to
perform functions on your computer without distracting your audience
from your presentation. To edit the Freeze key settings, click the Edit Freeze
Key option in the Assignments area. The following screen appears:

Figure 4-6, Edit Freeze Key screen

To use Freeze:

1 Press Pause on your Cyclops remote.

2 Use any of the remote keys to control your computer.

3 Press Pause again when you're ready to return to your presentation.

Once you freeze your screen, all of the other keys on your remote are
available to control your computer. This means you can edit your current
presentation, display slides from another presentation, or even open
another application — all without distracting your audience.

Note:  If you adjust the projector settings from your computer while you're
in Freeze mode, your changes will not display until you exit .
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STARTING AN EFFECT

Once you’ve customized an effect, you’re ready to use it.

1 Before the presentation, start Cyclops F/X, then minimize the main
screen.

2 During your presentation, press the key or button that you assigned to
each effect to start the desired effect.

THE PRESENTATION EFFECTS

The following are the Presentation Effects. To end any of the effects, press
the Esc key on your keyboard or the key on remote that you assigned for
that effect.

Break Timer is a digital timer that counts down from a duration you set.
Once you start the timer, click the MouseDisk once to lengthen the
duration.

You can also use Break Timer to  play a sound or select a background color
or picture. If your computer is equipped with a sound card, you can select a
.WAV file and play it continuously while the timer is running, or use it as an
alarm that sounds when the timer expires.

To set a transparent background, uncheck Color and Picture. To display a
picture, check Picture, click File, then select the desired .BMP file.

Center Cursor centers the mouse pointer on the screen. This helps prevent
“losing” the cursor.

Custom Cursor changes the appearance of the mouse pointer to one of 30
images. Only the standard arrow pointer changes. The other standard icons
(such as the hourglass) are not affected.

Detail Cursor magnifies the area around the pointer in a small rectangle.

Effects Menu displays a list of effects. Use this feature to start effects that
you haven’t assigned to a button or key. To start an effect, double-click its
name. Press Esc on the keyboard to close the list without starting an effect.

Highlight Bar draws a horizontal bar across the screen. Move the bar up or
down to draw attention to different areas on the screen . You can also
change the color and width of the bar.

Highlighter  works like a highlighter pen on your computer screen, by
overlaying a semi-transparent color on your screen. You can change the
color and width of the “pen.”
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Magnify enlarges a rectangular area around the mouse pointer. You can
choose from three levels of magnification (200 percent, 400 percent, or
800 percent).

Note: To enlarge the entire screen, use the Zoom effect.

Next/Previous advances to the next or previous slide.

Object allows you to draw rectangles, squares, ellipses, and circles. You can
change the color and width of each shape.

Refresh repaints the projected image. Use this feature to erase “remnants”
of Stamp and Telestrator effects.

Reveal hides the image, then lets you incrementally reveal more and more
of the image. You can specify a color for the hidden area, a horizontal or
vertical effect, and the size of the Reveal window.

Run Program starts a program that you choose.

Screen Blank blanks the screen to a color that you choose.

Sound plays a .WAV file when you press a button. You can play the sound
repeatedly or just once.

Note: You must have a sound card to use this effect.

Spotlight dims all of the image except for the area around the mouse
pointer. You specify the shape and size of the spotlight (circular, square, or
bar). Once you’ve started Spotlight, press the MouseDisk to change its size.
Another setting makes the Spotlight visible against a black background.

Stamp allows you to choose from 15 different bitmaps to “stamp,” or paste,
over the projected image. You can also choose to play a sound each time you
stamp.

Switch to F/X switches to the Cyclops F/X main screen.

Telestrator turns the mouse into a freehand drawing tool. You can
customize the color and width of the line and “constrain” the drawing to
only horizontal or vertical lines.

Ticker Tape displays a scrolling text message across the image. Just specify
the text of that you want to appear, the typeface, and the point size. You can
play a sound file each time the message runs across the image, and
customize the background color and picture.
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Title Screen projects an image from a .BMP file. You can use this effect to
show a predefined image with transition effects during a presentation. You
can also play an associated sound. Just specify which file to play and
indicate whether to play it when the image appears or continuously.

Zoom enlarges the entire image to 200%,400%, or 800% of its original size.
You choose whether to show the mouse pointer during a Zoom and indicate
the level of magnification.  If you check the Show Cursor During Zoom
checkbox, left-click to manually cancel the zoom. If you uncheck the Show
Cursor During Zoom checkbox, left-click to change the zoom factor.

Note: Most effects have an option that lets you rename the command itself.

MENU COMMANDS

File menu

The File menu offers the following commands for working with profiles of
effects.

MENU ITEM FUNCTION

Reset to defaults Resets the F/X options to the factory defaults.

Open Opens a previously saved profile of settings.

Save Saves recent changes to the current profile.

Save As Saves the profile settings under a name and location you specify.

Exit Quits the F/X program.

Effects menu

The Effects menu lets you change the items in the effects list.

MENU ITEM FUNCTION

Edit Allows you to edit F/X options.

Test Tests the current effect.

Add Allows you to add an effect.

Duplicate Allows you to copy an effect.

Delete Allows you to delete an effect.
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Options menu

The Options menu offers commands that allow you to set up assignments
on the remote, wand, or laser pointer, change the look and feel of the cursor,
and change the COM port settings.

MENU ITEM FUNCTION

Setup Remote Allows you to display the assignments area for the Cyclops

remote control or the optional Cyclops wand or laser pointer.

Cursor Options Changes the look and feel of the cursor. Also includes an option

that allows you to apply one of the Cyclops F/X custom cursor

options to Windows.

Connect Allows you to edit the COM port settings for your computer.
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Chapter 5

Maintenance

Periodic maintenance will keep your DP9100 in top working condition.

CLEANING THE LENS AND MIRROR

To clean the projection lens and mirror:

1 Take a piece of lens tissue and form it into a loose swab. Wet it with lens
cleaning fluid or denatured alcohol, and gently wipe it over the surface of
the lens or mirror.

2 Take another clean piece of lens tissue and repeat the process, wiping it
over the lens or mirror in the opposite direction.

Repeat this process until no smudges or particles can be seen. DO NOT
LOOK DIRECTLY INTO THE LENS WHEN THE LAMP IS ON!

Caution: Do not use acetone to clean the lens. It may remove paint from
areas around the lens or mirror and leave a residue on the glass.

CLEANING THE PROJECTION WINDOW

The projection window is the surface through which the LCD image is
projected. To maintain a clear, sharp image, you should clean the projection
window from time to time.

To clean the surface of the projection window:

1 Use a can of compressed air to blow dust off of the LCD panel inside the
projector. Point the can into the opening in the top center of the right
side of the projector (see Figure 5-1).
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Figure 5-1, Blowing air into the projector

2 Take a piece of lens tissue and form it into a loose swab. Wet it with a
solution of approximately ten percent Isopropyl alcohol and water, and
gently wipe it over the surface of the projection window.

3 Take another clean piece of lens tissue and repeat the process, wiping it
over the projection window in the opposite direction.

4 Repeat if necessary.

Caution: Do NOT use lens cleaning fluid  to clean the projection
window. It may damage the to the surface.
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REPLACING THE LAMP

For best performance, you should replace the lamp after 700  hours of
operation.

Note: Do not touch the lamp with your bare hands. Use gloves or a soft cloth
and handle it using the metal ends only.

Removing the old lamp

1 Leave the projector running with the lamp off for at least five minutes
before you change the lamp. This allows the fan to cool the lamp
chamber.

2 After the lamp has cooled sufficiently, turn off the projector and unplug
the power cord. (As a safety feature, the lamp chamber can’t be opened
until the power cord has been removed.)

3 Slide the AC lock button in the direction of the arrow. This button will
not move unless the power cord has been disconnected from the
projector.

4 While sliding the AC lock button, remove the left side cover by sliding it
about 1/4 of an inch to the left. When the cover releases, pull it straight
off (see Figure 5-2).

Figure 5-2, Sliding the rear panel off of the projector
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5 Locate the door to the lamp chamber on the right side of the left panel. It
has one slotted captive screw. With a screwdriver or coin, loosen the
screw, then open the lamp chamber door  (see Figure 5-3).

Figure 5-3, Opening the lamp chamber door

6 Locate the thumbscrew on the right side of the lamp and unscrew it.
When the thumbscrew is loose enough, gently pull the lamp from the
right socket and then slide it out from the left.

Installing the new lamp

 Caution! Make sure to wear gloves or use a soft cloth to handle the new
lamp. Never touch the lamp with your bare hands, as this can significantly
shorten the life of the lamp. If you do touch a portion of the lamp with your
bare hands, wipe it off with a soft cloth moistened with denatured alcohol.

To install a new lamp:

1 Remove the lamp from the package.

2 The lamp has thumbscrews on both ends. Remove the thumbscrew from
the end of the lamp that has no printing. Discard the thumbscrew.
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3 Slide the end of the lamp without the thumbscrew into the slot on the
left side of the lamp chamber (see the Figure below).

Figure 5-4, Sliding the lamp into place

4 Slide the end of the lamp with the thumbscrew into place, with the glass
pinch-off on the lamp pointing up, and tighten the thumbscrew. Make
sure to tighten the thumbscrew as much as possible. Pull the lamp to
make sure that it's securely seated.

5 Close the lamp chamber door and tighten the captive screw.

CLEANING/CHANGING AIR FILTERS

To make sure that your DP9100 operates safely and efficiently, you should
change or replace the filters after every 250 hours of operation. It is best to
change or clean all of the projector's filters at once. To clean the filters, wash
them in a solution of warm, soapy water.

There are three air filters in your DP9100.

Accessing the top filter

To access the top filter:

1 Remove the left side door, as described in the previous section.

2 Unscrew the three screws located at the top of the left side area (see
Figure 5-5).
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Figure 5-5, The three left-top retaining screws

3 Unsnap the top left cover by lifting it up and pulling it out (see
Figure 5-6).

Figure 5-6, Lifting the top left cover out

The filter is located on the inside of the top left cover (see Figure 5-7).

Figure 5-7, The top cover filter
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4 There is a plastic grill covering the filter. Pull on the handle in the center
of the grill to access the filter.

To replace the top cover, reverse steps one through three, taking care to align
the cover before snapping it into place.

Accessing the right filters

Before you can access the right filters, you must remove the left side door
and top left cover. See steps 1 through 3 above for more information.

To access the right filters:

1 With the projection arm down and locked, turn the projector on its side,
with the handle facing up.

2 Locate the screws on the bottom side of the right panel. Loosen the three
screws.

Figure 5-8, The three bottom screws

3 Turn the projector back to its base and raise the projection arm.
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4 Locate the screws holding the main top cover in place (see Figure 5-9).
Remove the three screws and lift up on the screw mountings until the
cover is loose. Gently pull the cover up and to the left of the projector
until it releases.

OVERTEMP

VOLUME

SOURCE FIT-TO-VIEW POWERCLEAR

SETUP

MENU

REPL   LAMP

Figure 5-9, The three top cover screws

5 While still holding the cover, remove the ribbon cable on the underside
of the control panel. Place the cover on a soft cloth.

 Caution! Never touch the LCD panel located underneath the top-cover
projection lens. Use caution when changing the filters.
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6 Locate the three screws at the top of the right side panel. Remove the
screws and unsnap the panel, from the rear first.

Figure 5-10, The screws at the top of the right side panel

7 The filters are now exposed (see Figure 5-11). Remove the retaining screw
to access the rear filter. Pull the front filter out.

Figure 5-11, The two right side filters

To replace the covers, reverse steps one through five, taking care to align the
top and side covers. Make sure to reattach the ribbon cable before you
replace the top cover. The ribbon cable is keyed, so it will only reattach on
one side. Also, make sure that the arm release lever is in the release position
(fully to the left) before you replace the top cover.
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REPLACING THE BATTERIES IN THE REMOTE CONTROL

1 Locate the battery compartment on the end of the remote control. Press
down while you slide the cover off of the compartment.

Figure 5-12, Installing batteries in the remote control

2 Remove the old batteries and replace them with new ones. Make sure you
align the batteries in the proper direction.

3 Slide the cover back onto the battery compartment, snapping it into
place.

TEMPERATURE EXTREMES

Your projector should not be stored in excess of 140˚ F (50˚ C). The
maximum operating temperature is 80˚ F (27˚ C).

If the projector has been exposed to extremely cold temperatures, you
should allow it to warm up to room temperature before you begin your
presentation.

In general, the recommended maximum operating temperature drops 1˚ C
for every 1,000 feet (305 meters) above sea level.
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Chapter 6

Troubleshooting

This chapter provides answers to some commonly asked questions about
the Desktop Projector 9100.

TROUBLESHOOTING CHART

Please refer to this troubleshooting chart and the following adjustment
recommendations before calling for assistance.

PROBLEM LIKELY CAUSE POSSIBLE SOLUTION(S)

No computer image 1. Loose cable. 1. Check and secure cable

projected.     connections.

2. No power to computer. 2. Turn on computer.

3. Incompatible video system. 3. If possible, check computer

    with another monitor.

4. No power to projector. 4. Power switch; AC cord

    plugged in (both ends); outlet

    on.

5. External video port not 5. Activate the external video

    activated.     port on your notebook.

    Cycle the power on your

    notebook with your projector

    connected and turned on.

No image on 1. Loose cable. 1. Connect cable.

computer screen. 2. Wrong video cable. 2. Use correct video cable.

3. BNC cable not connected 3. Make sure cable is correctly

    correctly.      attached at both ends.

Monochrome on Computer was turned on 1. Turn projector on.

color monitor. before projector. 2. Restart computer.

Streaks on Video cable plugged into Check and reset cable

monitor. computer is upside down. connections.

Faint screen. Low contrast. Adjust CONTRAST.

Jittery, fuzzy Out of sync. Adjust SYNC setting.

letters.
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PROBLEM LIKELY CAUSE POSSIBLE SOLUTION(S)

Image off-center. Position controls (arrow keys) Adjust position controls. If

or the Hpos/Vpos controls image will not center, check for

in the menus. compatibility problems.

Cannot get entire 1. The default resolution for all 1. Press the Fit-to-View key to

image on screen;     images larger than 1024 x 768     see the entire image, or use

scrambled image.     is 1024 x 768.     the arrow keys to pan the

    image.

2. Compatibility problem. 2. Make sure your system is

    compatible with the standards

    listed in Appendix A.

Black border The full 800 x 600 image is The projector is functioning

appears around displayed in 1024 x 768 mode. normally. Disregard.

800 x 600 images. The black area is not used.

Image appears to Incorrect interlace signal Select the opposite interlace

have lines selected. signal (even/odd).

“swapped.”

One or more colors SYNC, BRIGHTNESS, or Adjust SYNC, BRIGHTNESS,

“shimmer” on- CONTRAST is out of or CONTRAST settings.

screen. adjustment.

No video image 1. Video source(s). 1. Check video source(s)

projected.     (composite or S-Video) for

    power and proper

    operation.

2. Loose/improper cabling. 2. Secure cabling between video

    source(s) and projector.

Colors weak in 1. Video source (s). 1. Check for faulty video source,

video (NTSC/PAL/     bad connection, or frayed

SECAM) mode.     cable.

2. CONTRAST setting may be 2. Adjust CONTRAST level.

    too low.

Getting excess Video signal level too high. Adjust CONTRAST level.

white or washout
in video mode.

Black and white Ambiguity in video signal. Activate Input Source menu and

image from color select SECAM as the video

SECAM input. source mode.
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PROBLEM LIKELY CAUSE POSSIBLE SOLUTION(S)

Remote control Batteries upside-down or old. Check battery placement or

does not work. replace with new batteries.

Tiny dim or colored This is a normal LCD effect. None.

points of light.

Overtemp light 1.  Airflow is blocked. 1. Ensure that the shorter sides

is illuminated.     are unobstructed. Cycle the

    power and try again.

2.  Filters are clogged. 2.  Clean or replace filters.

3.  Fan is malfuntioning. 3.  Projector needs service.

Rainbow image. Lamp pinch-off not pointing up. 1. Adjust lamp position to point

    pinch-off straight up.

2. Ensure thumbscrew is very

    tight.

Discolored image. Lamp is not seated properly. 1. Adjust lamp to ensure it is

    firmly seated in the clamps.

2. Ensure thumbscrew is very

    tight.

DP9100 PARAMETER ADJUSTMENTS
If the auto-selected computer source parameters are incorrect for your
application, or the computer system you are using is not one of the many
stored in the DP9100 (refer to the compatibility list beginning on page 6-9),
it may be possible to select a closer source mode.

1 Open the DP9100’s Input Source Menu and record the H Sync and V Sync
values in the Input Measurements window for the incoming video signal.

Input Measurements
V Sync:   72.00 Hz  







H Sync:   78.00 KHz  







Lines:  1057     Sense:  HLHL

Figure 6-1, Input measurement window

2 If possible, consult your computer’s technical documentation for your
system’s Video Data Rate (Dot Clock) specifications.
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3 After you have determined your video specifications, find the closest
computer parameter entry in the compatibility list. Next, open the
DP9100’s Source Mode menu and scroll up or down through selections to
find the closest source mode. Use the right arrow key to load the mode of
choice.

Further parameter adjustments may be required to correct image problems
for the “best” input source selection. A basic explanation of the adjustment
functions follows.

Note: Parameter modifications are saved each time you close the menus or
turn off the power.

Adjusting Contrast and Brightness

Adjust the Contrast so that the colors (particularly the gray shades) are right
for the projected image. Buttons should look three-dimensional, as they do
on your monitor. Adjust the Brightness to make the image clear.

Adjusting Sync

Adjust the Sync control to shift the dot clock’s phase to match the phase of
incoming video signal. An incorrect Sync setting causes “sparkles” and
horizontal streaks randomly across the screen.

Adjusting the Dot Clock

The Dot Clock control adjusts the projector’s dot clock frequency to match
the incoming video signal’s frequency. An incorrect dot clock adjustment
causes faint, uniformly spaced vertical lines of video distortion/shading.

Adjust the Dot Clock control slowly in the direction that causes the
lines/bands of shading to get wider and fewer in number. There will be no
bands of distortion/shading when correctly adjusted.

Adjusting the Horizontal Position

The Hor. Pos (Horizontal Position) control adjusts the amount of blanking
before each horizontal line. Incorrect horizontal position adjustment can
cause either side of the projected image to extend beyond the viewing area,
end of line wrap around, or a half-normal display size.
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Adjusting the Vertical Position

The Vert. Pos (Vertical Position) control adjusts the amount of blanking
before each video frame. Incorrect vertical position adjustment can cause the
projected image to extend above or below the viewing area, video frame
overlap (lines from the bottom of one frame superimposed on the top of
the next frame, or a horizontal or vertical double image).

Adjusting the VCO Gain

The Voltage Control Oscillator’s (VCO) gain affects how well the Dot Clock
locks to the incoming horizontal sync signal. Incorrect VCO Gain is
indicated by lines shooting through the display or severely compressed or
shifted displays.

ADJUSTING YOUR DISPLAY

Horizontal Double Image

Figure 6-2, Adjusting the horizontal position

Adjusting the Horiz. Pos control will usually correct this problem. Use the
arrow keys on the control panel, the Setup key, or the following procedure:

1 Press the Menu key. The Main menu displays.

2 Select Advanced.

3 Select Vert. Pos (Vertical Position).

4 Press the down arrow key until the image is properly aligned.

Note: There are separate Vertical Position values for Normal and
Fit-to-View modes. Adjustments in one mode are not made in the other.
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Half-Normal Height Display

Figure 6-3, Adjusting the half-normal height display

Use the arrow keys, the Setup key on the control panel, or use the following
procedure to adjust the half-normal height display:

1 Press the Menu key. The Main menu displays.

2 Select Advanced from the Main menu.

3 Select the Hor. Pos (Horizontal Position) slide bar.

4 Press the down arrow key until the is properly aligned. (If this adjustment
does not correct the problem, reset the Hor. Pos control.)

Note:  There are separate Hor. Pos and Vert. Pos values for Normal and
Fit-to-View Modes. Adjustments in one mode are not made in the other.

5 Press the right arrow key to select the Vert. Pos (Vertical Position) slide
bar.

6 Press the down arrow key until the image displays properly.
(If this adjustment does not correct the problem, reset the Hor. Pos
control to the default.)

If neither parameter corrects the problem, you must find the correct Dot
Clock value to prevent image distortion. Make changes to this parameter
SLOWLY to avoid skipping over the desired value. Considerable trial and
error may be required.

7 Select Image on the Main Menu.

8 Select the Dot Clock slide bar with the right arrow.

9 Move the slide bar up or down until the image displays properly.

If none of these adjustments corrects the problem, try a different SOURCE
MODE selection. Make sure the selection has the correct resolution and the
closest V-sync and H-sync values.
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Vertical Double Image

Figure 6-4, Adjusting the vertical position

Use the Setup key or the following procedure to adjust the Vert. Pos control:

1 Open the Main menu.

2 Select Advanced.

3 Select Vert. Pos (Vertical Position).

4 Press the down arrow key until the image is properly aligned.

Note:  There are separate Vert. Pos values for Normal and
Fit-to-View Modes. Adjustments in one mode are not made in the other.

If this adjustment does not correct the problem, try a different Source Mode
setting. Make sure the selection has the correct resolution and the closest
V-sync and H-sync values.

Faint, Vertical Lines of Distortion

1 Use the Cyclops remote control to adjust the sync first. If the lines of
distortion move uniformly across the screen as you adjust the sync, there
is a Dot Clock problem.

2 Adjust the Dot Clock SLOWLY so that the shading gets further and further
apart, until it is gone. Considerable trial and error may be required to
avoid skipping over the correct value.

Dark, Vertical Lines of Distortion

Dark, uniformly spaced vertical lines (sometimes with smaller lines on
either side of each dark line) may be seen in Fit-to-View mode or Normal
Mode, or both. Any of the following steps may eliminate this problem.
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Dark Lines in Fit-to-View Mode Only

1 With the menus closed, use the arrow keys on the control panel to pan
the image down until it stabilizes.

2 Adjust the contrast.

3 Change the colors to 226k.

4 Change the computer screen’s background colors. Certain colors may
cause this pattern to appear in Fit-to-View Mode.

Dark Lines in Normal Mode Only

1 Adjust the contrast.

2 Change the colors (Preferences menu; Colors) to 226k.

3 Change the computer screen’s background colors; certain colors may
cause this pattern to appear in Fit-to-View mode.

Noise, Flickering Pixels, or Distortion

1 Use the Cyclops remote control to adjust the sync first. Make sure you use
the entire range of sync adjustments before you proceed to Step 2. Many
severe-looking distortions can be corrected using sync.

Note:  There are separate sync values for Normal and Fit-to-View modes.
Sync adjustments made in one are not applied to the other. Make
adjustments in both.

2 If sync does not correct the problem, adjust the Dot Clock. Make changes
to this parameter slowly to avoid skipping over the desired value.
Considerable trial and error may be required.

3 If the problem still exists, adjust the VCO Gain.

UNKNOWN/UNRECOGNIZED VIDEO SOURCE

Occasionally, an unknown or unrecognizable video signal is encountered
while using the DP9100. If you encounter an unknown or unrecognizable
video signal, use the following steps to connect and adjust the projector:

1 Connect the projector to the video source and make sure that the power is
on.

2 Select User A or B for a custom setting (Advanced menu).

3 If it is not already selected, select Computer input on the Source menu.
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4 Check the Input Measurements window and record the V Sync, H Sync,
and Lines values for the incoming video signal. Consult your computer’s
documentation for the Video Data Rate (dot clock) specifications.

Input Measurements
V Sync:   72.00 Hz  







H Sync:   78.00 KHz  







Lines:  1057     Sense:  HLHL

Figure 6-5, Input measurement window

Note:  The Lines value will be larger than the vertical lines of data displayed.
This is due to additional vertical lines that are sent by the video system for
video processing timing purposes.

5 In the Source Mode menu, select the source mode closest to the values
recorded in the step above.

6 Make adjustments as necessary to fine-tune your display.

7 Close the menus to save these settings.

COMPATIBILITY LIST

The following pages list the workstation/computer video signal
characteristics stored in the DP9100's memory.

This list is subject to change as more platforms are supported. If your system
is not listed, call Proxima for more information.
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*Denotes interlaced models

lebaL rerutcafunaM sySoediV/ledoM noituloseR klCtoD
)zHM(

cnySH
)zHK(

cnySV
)zH(

1SWE IGS emertxE,ZX,LX,2ogidnI,ydnI 4201x0821 041 79.18 67

2SWE hpargretnI 09G,5-DT,4-DT,2-DT 4201x0821 031 52.18 67

3SWE cireneG 4201x0821 531 08 67

4SWE nuS XGobruT,XG,2CRAPS 4201x0821 531 08 67

ASEV cireneG 4201x0821 3.431 34.87 47

5SWE PH 537,521/537 4201x0821 531 87 27

ASEV cireneG 4201x0821 821 77 27

6SWE CED 003/0003 4201x0821 6.231 8.67 27

7SWE IGS emertxE,ZX,LX,2ogidnI,ydnI 4201x0821 031 9.67 27

8SWE nuS +XG2CRAPS 4201x0821 711 27 76

9SWE CED 0003 4201x0821 8.911 3.07 66

01SWE elopdaT 3koobCRAPS 4201x0821 77.111 5.46 06

ASEV cireneG 4201x0821 6.411 46 06

11SWE MBI 0006SR 4201x0821 5.111 63.36 06

21SWE IGS emertxE,ZX,LX,2ogidnI,ydnI 4201x0821 53.701 9.36 06

31SWE hpargretnI 19G,5-DT,4-DT,2-DT 4201x0821 601 8.36 46

CAM elppA CPrewoP 4201x0821 531 08 57

CAM elppA 069x0821 36 57 57

41SWE elopdaT koobCRAPS 009x2511 5.501 8.17 67

51SWE elopdaT 2CRAPS 009x2511 5.501 8.17 67

61SWE nuS 2CRAPS 009x2511 001 7.17 67

ASEV cireneG 009x2511 601 07 47

CAM elppA caMrewoP,506ardauQ 078x2511 001 96 57

ASEV cireneG 009x2511 8.301 86 27

71SWE nuS +XG,XG2CRAPS 009x2511 5.49 26 76

81SWE elopdaT 3koobCRAPS 009x2511 39 26 66

91SWE TXeN noitatsTXeN 078x2511 8.89 6.06 86

ASEV cireneG 468x2511 4.901 67 08

ASEV cireneG 009x2511 58 5.55 06

52SWE nuS XGobruT2CRAPS 009x2511 5.49 7.16 66

ASEV cireneG 009x2511 8.89 66 07

02SWE hpargretnI 19G,09G,5-DT,4-DT,2-DT 867x4201 401 52.18 823.99

ASEV cireneG 867x4201 08 36 57
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lebaL rerutcafunaM sySoediV/ledoM noituloseR klCtoD
)zHM(

cnySH
)zHK(

cnySV
)zH(

ASEV cireneG 867x4201 5.48 5.26 87

12SWE elopdaT 3koobCRAPS 867x4201 3.18 2.16 67

CAM* elppA CPrewoP 867x4201 08 06 57

AGX elppA caMrewoP,)"91(506ardauQ 867x4201 7.47 4.65 07

AGX cireneG 867x4201 08 3.35 76

ASEV cireneG 867x4201 3.46 88.84 06

ASEV cireneG 867x4201 3.77 1.85 27

ASEV cireneG 867x4201 56 5.84 06

22SWE IGS emertxE,ZX,LX,2ogidnI,ydnI 867x4201 3.46 88.84 06

32SWE PH 537,521/537 867x4201 56 5.84 06

42SWE IDR etiLIDR 867x4201 05 5.64 06

ASEV elopdaT 3koobCRAPS,2koobCRAPS 867x4201 56 5.74 06

ASEV cireneG * 867x4201 05 8.73 64

potpaL abihsoT *C0054T 867x4201 54 4.53 34

A4158 MBI *A4158 867x4201 6.34 5.43 5.34

potpaL abihsoT TDC0512 867x4201 44 4.53 34

CAM elppA 867x4201 08 06 57

AGVS elppA CAM 006x008 15 41.84 27

ASEV cireneG 006x008 04 9.73 06

potpaL elopdaT XG3koobCRAPS 006x008 3.63 63 5.75

ASEV cireneG 006x008 63 61.53 65

AGVS elppA CAM 006x008 63 42.53 65

potpaL abihsoT 0054T 006x008 7.63 53 4.65

AGV cireneG 084x046 52 5.13 06

AGV cireneG 084x046 5.13 83 27

AGV cireneG edoMtxeT 084x027 52 5.13 07

AGV abihsoT TDC0512 084x046 52 9.13 06

AGV cireneG 084x046 23 83 57

AGV abihsoT TDC0512 006x008 04 93 5.26

CAM elppA 426x238 3.75 37.94 5.47

CAM elppA CL 084x046 4.13 53 76

CAM elppA "31 084x046 3.03 53 66

AGV elppA CAM 084x046 03 7.43 66

AGV cireneG 084x046 52 5.13 06

AGV elopdaT 3koobCRAPS,2koobCRAPS 084x046 52 56.03 3.95
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WHERE TO GET HELP

If you still need help after checking the Troubleshooting Chart and making
adjustments, or you need replacement parts, call your dealer’s technical
support line. If your dealer cannot solve your problem, please call Proxima
Customer Service at:

U.S.A. and Canada Europe:
(619) 457-5500 +31-43-358 5200
Press 1 for Customer Service +31-43-358 5201 (Fax)
Fax: (619) 457-8542

Outside U.S.A. and Canada World Wide Web
(619) 457-5500 http://www.prxm.com
Press 1 for Customer Service Click Customer Service.
Fax: (619) 622-0173
Fax: (619) 457-8542

RETURNS

If your projector is determined to be defective, you will be issued a Return
Material Authorization Number. After you have received this number, send
the projector, all cables, a copy of your sales receipt, and a description of the
problem, freight prepaid, to Proxima. Clearly note the Return Material
Authorization Number on the outside of the shipping box.

Note:  A carton without a Return Material Authorization Number on the
outside will be returned unopened by Proxima.

Send authorized returns to:

U.S.A. and Canada: Europe:
Proxima Corporation Proxima Corporation
RMA #______ RMA#______
9440 Carroll Park Drive Horsterweg 24
San Diego, CA 92121-2298 6191 RX Beek

The Netherlands

Please ship the projector in its original container. If the original package is
not available, contact Proxima for packaging.

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



   
   

   
   

   
   

   
   

   
  

Specifications  A-1

Appendix A

DP9100 SPECIFICATIONS

Color 16.7 Million Colors

Display Technology LCD: Active Matrix 1024 x 768

Resolution Multiple Graphics Modes (640 x 480, 800 x 600,
1024 x 768, 1152 x 900, 1280 x 1024

Contrast Ratio 100:1 Typical

Video Compatibility NTSC M 3.58 MHz; PAL B, G, H, I 4.42 MHz; SECAM 4.43
MHz; S-VIDEO

Projection Lamp 575 Watt Metal Halide

Brightness 300 ANSI Lumens (typical)

Keystone Correction 4.5 degrees

Audio System Digital Stereo Sound, two built-in 3 Watt Speakers

Inputs 1 Computer Video
2 Composite Video (NTSC, PAL, SECAM)
2 S-Video
1 Computer Stereo Audio
2 Composite Video Stereo Audio
1 Microphone
Cyclops Interactive Pointer System

Outputs Stereo Audio (2 RCAs)
2 Monitor

Power Source 90-265 VAC, 50-60 Hertz

Dimensions Closed -13.8” (H) x 19.8” (W) x 7.3” (D)
(35 x 50.2 x 18.5 cm)
Open - 13.8" (H) x 19.8" (W) x 25.1" (D)
(35 x 50.2 x 63.75 cm)

Weight 31.6 lbs. (14.3 kg)

Projection Distance 4 ft. to 12 ft. (1.22 m to 3.7 m)

Compatibility IBM PC, PS/2 and compatibles

Apple: Macintosh II, LC, Quadra, Centris, Performa, and

PowerBook. Apple Macintosh Classic, Classic II, compact

Macintosh family.

Workstations: Sun, Hewlett-Packard, IBM RS/6000,

Silicon Graphics, DEC Alpha, Intergraph,NeXT.
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Accessories and Replacement Parts    B-1

Appendix B

Accessories and Replacement Parts

REPLACEMENT PARTS

PART PART NUMBER

Replacement lamp L71

Cyclops remote control A95

Power Cord, IEC, North America C1002-10

Power Cord, IEC, Europe C1001-10

Power Cord, IEC, Italy C1003-10

Power Cord, IEC, UK C1004-10

VGA to LCD cable C800-6

Mac to LCD adapter C804-0

Mac to LCD cable C802-6

Mac ADB cable C470-6

13C3 to LCD cable C801-6

SGI to LCD adapter C947-12

SGI 13C3 to LCD cable C943-6

DEC 3C3 to LCD adapter C947-10

DEC 3C3 to LCD cable C948-6

S-Video cable C466-6

Computer Audio cable C498-6

Serial cable C936-6

Composite audio/video cable C497-6

Mini-jack to RCA cable adapter C5105

Cyclops F/X diskettes

(Windows/Macintosh) A50F/X
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B-2    Appendix B

ACCESSORIES

PART PART NUMBER

MediaExpress Image Display System ME90H

Cyclops Interactive Pointer System A2079

Cyclops Laser Pointer A90

Powered Loudspeaker System A55

Desktop Projector Rolling Hard Case A297

BNC Cable Kit A37
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Sense Lines    C-1

Appendix C

Sense Lines

This appendix explains how to adjust the projector if you’re having trouble
connecting to a computer with no external monitor.

WHAT ARE SENSE LINES?

Certain display cards and video systems rely on sense line information from
the monitor to correctly configure themselves for display resolution. The
absence of sense line information causes some display cards to output a
default video signal, and actually prevents some video cards from outputting
video at all.

Sense line information is only required when you are using a system
without a monitor and the video card defaults to an incompatible
resolution. Sense line information can be found in the technical
documentation that came with your computer.

CONFIGURING THE DESKTOP PROJECTOR 9100

1 Determine the default resolution for your video system.

2 Gather sense line information from your computer documentation or
from your video card documentation. Typical sense line settings are listed
later in this appendix.

3 Connect and turn on the projector.

4 Choose the Advanced menu.

5 Set Sense 3, Sense 2, Sense 1 and Sense 0 to the settings recommended for
your system.

6 Exit the menus and restart your computer (do not turn off the projector).

THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES



   
   

   
   

   
   

   
   

   
  

C-2    Appendix C

MACINTOSH DISPLAYS

The next table shows typical sense line settings for Macintosh systems, based
on the system’s resolution. Try these settings only if you have trouble
projecting an image without an external monitor connected to the
computer.

 Remember to restart your computer after you make these changes.

DISPLAY RESOLUTION SENSE LINE SETTING(S)

640 x 480 Sense 3: High

Sense 2: High

Sense 1: High

Sense 0: Low

1152 x 870 Sense 3: High

Sense 2: Low

Sense 1: Low

Sense 0: Low

832 x 624 and 1024 x 768 Your system needs a Macintosh terminator. Try the

Macintosh Sync Adapter (02-20-UNV) available from

Griffen Communications Corp., 1451 Elm Hill Pike,

Park Elm Bldg, Suite 100, Nashville TN 37210

(615) 399-0990 fax: (615) 399-7060.

IDENTIFYING SENSE LINE SETTINGS

To determine the current sense line setting:

1 Connect the projector to the computer and the monitor.

2 Make sure all hardware is turned on and that the correct resolution is
displayed on the monitor and through the projector.

3 Open the projector’s menus and choose Input Source,
Input Measurements. The four sense line settings will appear in the
window.

Input Measurements
V Sync:   72.00 Hz  







H Sync:   78.00 KHz  







Lines:  1057     Sense:  HLHL

Figure C-1, Input Measurements windows
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Sense Lines    C-3

Sense line settings for popular video cards:

METSYS RODRACCIHPARG
EPYTROTINOM

NOITULOSER ESNES
3

ESNES
2

ESNES
1

ESNES
0

drakcaP-ttelweH kooBinmO 084x046 hgiH hgiH hgiH woL

kooBrewoP/CAM 1 "31BGR 084x046 hgiH hgiH hgiH woL

)2rotanimrethtiw("61 426x238 hgiH hgiH hgiH hgiH

)2rotanimrethtiw("91BGR 867x4201 hgiH hgiH hgiH hgiH

"12BGR 078x2511 hgiH woL woL woL

noitatsCRAPSnuS XG zH66009x2511 hgiH woL hgiH hgiH

zH67009x2511 hgiH hgiH woL woL

zH674201x0821 hgiH woL hgiH woL

sulpXG zH66009x2511 hgiH hgiH hgiH hgiH

zH67009x2511 hgiH hgiH hgiH woL

zH764201x0821 hgiH hgiH woL woL

sulpXGobruT/XGobruT zH06867x4201 hgiH hgiH woL hgiH

zH66009x2511 hgiH hgiH hgiH hgiH

zH67009x2511 hgiH hgiH hgiH woL

zH764201x0821 hgiH woL hgiH woL

zH674201x0821 hgiH woL hgiH hgiH

XZ zH67867x4201 hgiH woL woL woL

zH66009x2511 hgiH woL hgiH hgiH

zH67009x2511 hgiH hgiH hgiH woL

zH674201x0821 hgiH woL hgiH woL

CRAPSnuS regayoV zH67867x4201 hgiH woL woL woL

zH67009x2511 hgiH hgiH hgiH woL

scihparGnociliS 3 ogidnI(nacsitluM 2 LXhtiw

)ydnIdnascihparg

zH674201x0821 woL woL woL hgiH

nacsitluM zH674201x0821 hgiH woL woL hgiH

nacSelgniS zH674201x0821 hgiH woL hgiH woL

nacSelgniS zH67867x4201 hgiH hgiH hgiH woL

IDR etiLrewoP zH67009x2511 woL hgiH woL woL

1 Per Apple, the PowerBook will only display resolutions up to 832 x 624.
2 The Griffin Mac Sync Adapter can select many different resolutions through switch
settings on the adapter itself.  Instructions to use these switches are included with
the adapter.  To contact Griffin regarding the adapter (part number 02-20-UNV):
Griffin Communications Corporation, 1451 Elm Hill Pike, Suite 100, Nashville, TN
37210, phone (615) 399-0990, fax (615) 399-7060.

3 Using sense lines with Silicon Graphics workstations requires the use of the
Proxima C943-6 SGI 13C3 to 13C3 cable.  This cable is available in the Proxima
SGI Cable Accessory Kit (part no. A36).
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Index

Index

A

Adapters   1-8
Adjusting the volume

Volume keys  2-7
Advanced features  2-12
Advanced menu  3-10

Hor. Pos  3-10
Sense 3, 2, 1, 0  3-10
User  3-10
VCO gain  3-10
Vert. Pos  3-10

air flow  1-21
arm release lever  1-2
Arrow keys  i-11, 2-3
AUDIO 1/2 In  1-7
audio adjustments  2-7

balance  2-8
bass control  2-7
displaying the volume slider  2-7
fade  2-8
treble control  2-7

Audio menu  3-7
Audio Mode  3-7
Balance  3-7
Bass  3-7
Fade  3-7
Mic. Volume  3-7
Mute  3-7
Treble  3-7
Volume  3-7

AUDIO OUT  1-7

B

balance  2-8
bass and treble controls  2-7
BNC Block to LCD Connector Cable  1-15
BNC Connections  1-15
BNC to LCD Connector Cable  1-16
Break timer  2-11
brightness setting  2-5

C

Cables
Included   1-8
Optional   1-8

Cleaning/changing air filters  5-5
right filters  5-7
top filter  5-5

Clear key  i-11, 2-3
Closing the projector  1-4
Compatibility List  6-9
composite audio/video cable  1-18
COMPUTER AUDIO IN  1-7
COMPUTER IN  1-8
COMPUTER OUT  1-8
Connecting a microphone  1-18
Connecting a monitor  1-8
Connecting an external stereo

system  1-20
Connecting external speakers  1-19
Connecting video and audio  1-17

computers  1-18
S-Video sources  1-18
VCRs  1-17

Connecting without a monitor  1-11
Connecting your computer

13C3 connections  1-13
BNC  1-15
DEC 3C3  1-15
Macintosh  1-10
Notebook computers  1-12
PCs  1-10

connector panel  1-7
AUDIO 1/2 In  1-7
AUDIO OUT  1-7
COMPUTER AUDIO IN  1-7
COMPUTER IN  1-8
COMPUTER OUT  1-8
CYCLOPS port  1-7
MIC  1-8
S-Video-1/2  1-7
VGA OUT  1-8
Video 1/2  1-7

contrast setting  2-6
control panel  i-10
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Index

Correcting shimmering or streaks  2-6
Adjusting the Sync  2-6

Correcting vertical banding  2-6
Adjusting the Dot Clock  2-6
Adjusting the Red, Green, and Blue

settings  2-6
Adjusting the Tint  2-6

Cyclops F/X  i-11, 2-2, 4-1
Cyclops interactive pointer system  i-2

connecting  1-16
Cyclops menu  3-3

Button  3-3
Calibrate  3-3

CYCLOPS port  1-7
Cyclops remote control  i-10, 2-1, 2-2

batteries  5-10
Fit-To-View/MediaExpress key i-11, 2-3
Lamp key  i-10, 2-3
Menu key  i-11, 2-3
MouseDisk  i-10, 2-2
Mute key  i-11, 2-2
Prog 1, 2 key  i-10, 2-2
programming  2-12
Reverse/Forward/Pause key  i-11, 2-2
Setup key  i-11, 2-2
Source key  i-10, 2-2
Volume keys  i-11

D

DEC 3C3 to LCD adapter  1-15
DEC 3C3 Video Connections  1-15
DEC 3C3-LCD connector cable  1-15
Desktop Projector 9100

description  i-1
diagonal image size   1-24
distance from screen 1-24
Dot Clock adjustment  6-4
DP9100

maintenance  5-1
power consumption  1-6
precautions  1-21

Draw toolbar  2-9

F

fade  2-8
fade and balance  2-8
filters   5-5
Fit-To-View feature  2-11

Fit-To-View key  i-11, 2-3
flip mirror  i-6

cleaning  5-1
release lever  1-3

focus  1-23
Forward key  i-11, 2-2
Freeze   4-8
FROM COMPUTER  1-9

H

H-Sync values  6-3
half-normal height  6-6
Hor. Pos

adjusting  6-4
Horizontal Double Image  6-5

I

image adjustments  1-23, 2-5
brightness  2-5
contrast  2-6
correcting keystoning  1-24
focusing the image  1-23
image size  1-24
raising or lowering the image  1-23

Image menu  3-5, 3-6
Blue  3-5
Bright  3-5, 3-6
Contrast  3-5, 3-6
DotClk  3-5
Factory Default  3-5
Green  3-5
Interlace  3-5
Red  3-5
Saturation  3-6
Sync  3-5
Tint  3-6

image position  2-6
image size  1-24
Input Measurements window  6-3
Input Source menu  3-4

Input Measurements  3-4
Source Mode  3-4
Source Select  3-4

input sources
definition  2-4
Source key  2-4
switching  2-4

Introduction  A-1
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Index

K

keystoning  1-24

L

lamp
replacing  5-3

installing the new lamp  5-4
lamp type   A-1
removing the old lamp  5-3

Lamp indicator  2-4
Lamp key  i-10, 1-22, 2-3
LightBoard tool  2-2, 2-8

Draw toolbar  2-9
lighting the lamp  i-9

M

Mac to LCD Adapter  1-11
MAC to LCD connector cable  1-11
Macintosh connections  1-10
Main menu  3-1

Advanced  3-1
Audio  3-1
Cyclops  3-1
Image  3-1
Input Source  3-1
Preferences  3-1
Projector  3-1
Tools  3-1

maintenance  5-1
cleaning the air filters  5-5
cleaning the lens and mirror  5-1
cleaning the projection window    5-1
replacing the lamp  5-3

MediaExpress Image Display System  i-2
connecting  1-16
PDF files  i-2

MediaExpress key  i-11, 2-3
Menu key  i-11, 2-3
menus

Advanced  3-10
Audio  3-7
changing the language  2-5
Cyclops  3-3
Image  3-5, 3-6
Input Source  3-4
Main  3-1
Preferences  3-9

Projector  3-8
reverting to factory defaults  2-5
saving your settings  2-5
Tools  3-2
using  2-4

MIC  1-8
monitor connection 1-8
MouseDisk  i-10, 2-2
Moving the projector  1-4

while open  1-5
Mute  i-11
Mute key  2-2, 2-7

N

Notebook connections  1-12
setting the projector as an external

monitor  1-12

O

Opening the projector  1-1
Overtemp indicator  i-11, 1-22, 2-4

P

Parts
Replacement  B-1

Pause key  i-11, 2-2
PC connections  1-10
PDF file  1-16
Positioning the projector  1-1
power switch  1-6
Powered Loudspeaker System  1-19
Preferences menu  3-9

Colors  3-9
Language  3-9
On-screen  3-9
Prog 2  3-9

Prog 1, 2 keys  i-10, i-11, 2-2
Projecting transparencies  2-11
projecting with a separate monitor  1-9
projection lens

cleaning  5-1
Projector menu  3-8

Lamp Hours  3-8
Projection  3-8

Proxima cables
included  1-8
optional  1-8
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Index

Q

Quick Start  i-4
connecting video and audio  i-9
connecting your computer  i-8
setting up the projector  i-5
turning on the projector  i-9

R

rear projection  2-7
recessed carrying handle  1-4
remote mouse tracking  2-8
Replace Lamp indicator  i-11
Replacement Parts  B-1
Return Material Authorization

Number  6-12
Reverse key  i-11, 2-2
reverse video   3-9

S

S-Video-1/2  1-7
See-it/Show it  i-11, 2-2, 4-6
sense lines  1-9

definition  C-1
Macintosh displays  C-2

Setting up the projector  i-5
Setup key  i-11, 2-2
SGI 13C3 to LCD connector cable  1-14
SGI connections  1-14

without an external monitor  1-14
SGI to LCD adapter  1-14
Source key  i-10, 2-2
source mode

selecting  6-3
Specifications  A-1
Sync adjustment  6-4
Sync setting  2-6

T

Technical Support  6-12
temperature extremes  5-10
13C3 connections

SGI  1-14
standard  1-13

13C3 to LCD Connector Cable  1-13
Tools menu  3-2

Break Timer  3-2

Break Timer Value  3-2
LightBoard  3-2
LightBoard Mode  3-2
Mouse Tracking  3-2

Troubleshooting  6-1
chart  6-1

Turning on the projector  1-21
Turning the lamp off  1-22

U

user profiles  2-12

V

V-Sync values  6-3
VCO Gain

adjusting  6-5
Vert. Pos

adjusting  6-5
Vertical Double Image  6-7
VGA OUT  1-8
VGA to LCD connector cable  1-10
VGA/MAC adapter  1-10
VIDEO 1/2  1-7
volume  2-7

Mute key  2-7
Volume keys  i-11, 2-2

W

What’s in the box  i-3
World Wide Web address  6-12
workstations 1-13
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This user manual is provided as a free service by FixYourDLP.com.  FixYourDLP is in no way responsible
for the content of this manual, nor do we guarantee its accuracy.  FixYourDLP does not make any claim
of copyright and all copyrights remain the property of their respective owners.

About FixYourDLP.com
FixYourDLP.com (http://www.�xyourdlp.com) is the World’s #1 resource for media product news, 
reviews, do-it-yourself guides, and manuals.

Informational Blog:  http://www.�xyourdlp.com
Video Guides: http://www.�xyourdlp.com/guides
User Forums: http://www.�xyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.�xyourdlp.com/counterfeits

RecycleYourLamp.org – Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research  - The trusted 3rd party lamp research company: 
http://www.lampresearch.com

Discount-Merchant.com – The worlds largest lamp distributor:
http://www.discount-merchant.com
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